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ABSTRACT 

Mitochondria play a central role in lipid metabolism and pathology in obesity and 

type 2 diabetes mellitus. Mitochondria have been shown to associate with lipid 

droplets (LDs) in multiple tissues but the functional role of these peridroplet 

mitochondria (PDM) is unknown. This work reveals that PDM have unique protein 

composition and cristae structure, and remain adherent to the LD in the tissue 

homogenate. We developed an approach to isolate PDM based on their adherence 

to LDs. Comparison of purified PDM to cytoplasmic mitochondria reveals that (1) 

PDM have increased pyruvate oxidation, electron transport, and ATP synthesis 

capacities. (2) PDM have reduced beta oxidation capacity and depart from LDs 

upon activation of brown adipose tissue thermogenesis and beta oxidation. (3) 

PDM support LD expansion as Perilipin 5-induced recruitment of mitochondria to 

LDs increases ATP-dependent triacylglyceride synthesis. (4) PDM maintain a 
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distinct protein composition due to uniquely low fusion-fission dynamics. We 

conclude that PDM represent a segregated mitochondrial population with unique 

structure and function that supports triacylglyceride synthesis. We suggest that 

increased mitochondrial recruitment to LDs may be part of a generalized adaptive 

response in physiological conditions that require LD expansion, such as post-

prandial lipid synthesis and storage. Furthermore, PDM-mediated LD expansion 

may play a role in muscle and liver injury from lipotoxicity in conditions of nutrient 

excess, such as obesity and hyperlipidemia. A better understanding of PDM and 

LD biology may therefore lead to new therapies for lipotoxic tissue injury and 

insulin resistance. 
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A good case can be made of our nonexistence as entities. We are not 

made up, as we had always supposed, of successively enriched packets of our 
own parts. We are shared, rented, occupied. At the interior of our cells, driving 
them, providing the oxidative energy that sends us out for the improvement of 
each shining day, are the mitochondria, and in a strict sense they are not ours. 
They turn out to be little separate creatures, the colonial posterity of migrant 
prokaryotes, probably primitive bacteria that swam into ancestral precursors of 
our eukaryotic cells and stayed there. Ever since, they have maintained 
themselves and their ways, replicating in their own fashion, privately, with their 
own DNA and RNA quite different than outs. Mitochondria are stable and 
responsible lodgers, and I choose to trust them. Without them, we would not 
move a muscle, drum a finger, think a thought.  
 
 

-Lewis Thomas 
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CHAPTER ONE: General Introduction 

The obesity epidemic 

Obesity is a rapidly rising epidemic that is associated with significant morbidity and 

mortality (Mitchell, Catenacci, Wyatt, & Hill, 2018). Obesity, defined as body mass 

index > 30kg/m2, currently affects one in three U.S. adults and disproportionally 

African and Hispanic Americans. Obese individuals have dramatically increased 

risk for developing type 2 diabetes mellitus, cardiovascular disease, cancer, and 

early death. In addition to the health consequences of obesity and type 2 diabetes, 

these diseases are associated with over $407.6 billion in direct costs and lost 

productivity. Improving the prevention and treatment of obesity is therefore of 

paramount importance for our collective health and prosperity.  

Obesity pathology and treatment 

Obesity is characterized by increased levels of circulating lipids that cause direct 

and indirect damage to most of the body’s major organ systems and vascular 

networks (Klop, Elte, & Cabezas, 2013). In healthy individuals, ingested foodstuffs 

are oxidized after a meal or sequestered into storage in the form of glycogen and 

triacylglycerides. During periods of fasting, the stored nutrients are released to 

maintain a constant nutrient supply to vital body organs. The alternate ingestion of 

foodstuffs and release of stored nutrients maintains a constant healthy level of 

circulating nutrients (~70-120mg/dL glucose and 50-150 mg/dL triacylglycerides). 

However, in obese individuals, excessive food intake combined with increased 
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endogenous glucose and lipid release results in chronically elevated levels of 

circulating nutrients, leading to gluco- and lipo- toxicities. Excess glucose and lipids 

accumulate in blood vessel walls, leading to microvascular injuries (nephropathy, 

peripheral neurophathy, retinopathy) in addition to promoting further insulin 

resistance and metabolic dysfunction. Prolonged exposure to high nutrients results 

in increased risk for macrovascular injuries (heart attack and stroke), ectopic fat 

deposition (non-alcoholic fatty liver disease and cardiomyopathy), and increased 

mortality. 

Efficacious treatment for obesity is currently severely limited. Diet, exercise, and 

lifestyle modifications are the primary methods of treatments but have limited long-

term success. Drug therapies include compounds that directly inhibit nutrient 

absorption from the gut or curb appetite by acting on satiety receptors in the central 

nervous system. For qualified patients, surgical resection of the gastrointestinal 

system is used as a last measure to limit nutrient intake and absorption when other 

approaches fail. Thus, there is a dire need to identify new and better ways to 

prevent and treat obesity.  

Brown adipose tissue 

Much of the treatment of obesity has thus far focused on weight loss and 

specifically the reduction of adipose tissue. However, not all adipose tissue is the 

same. While white adipocytes specialize in storing fatty acids and subsequently 

releasing them for other tissues to consume, brown adipocytes utilize lipid stores 
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for thermogenic fat oxidation in cold exposure (Barbara Cannon & Nedergaard, 

2004). Brown adipose tissue thermogenesis occurs due to the unique expression 

of Uncoupling protein 1 (UCP1), which permits increased rates of fatty acid 

consumption by uncoupling nutrient oxidation from ATP synthesis. Brown adipose 

tissue is therefore viewed as a therapeutic approach to reduce excess circulating 

fatty acids in and enhance weight loss in obese individuals (Boss & Farmer, 2012). 

Intracellular fat metabolism 

Mitochondria are the primary site of fatty acid oxidation in mammalian cells (Eaton, 

2002). Fatty acids are an essential fuel because of their high energy density and 

storage capacity relative to glucose. Indeed, mammals rely almost exclusively on 

fatty acids when fasting for more than several hours as well as during prolonged 

exercise when glycogen stores are depleted. Most cells store fatty acids as 

triacylglycerides in the form of lipid droplets to prevent toxicity from high levels of 

free fatty acids. Fatty acid packaging into triacylglycerides is an energy demanding 

process involving ATP-dependent ligation to coenzyme A followed by sequential 

esterification reactions to a glycerol backbone. While lipid droplets were initially 

viewed as static storage compartments for triacylglycerides, research from the last 

decade has revealed that lipid droplets have a distinct proteome with dynamic 

signaling networks (Farese & Walther, 2009). For example, when fatty acids are 

needed to fuel the cell, multiple signaling pathways recruit and activate lipase 

enzymes at the surface of lipid droplets (Zechner et al., 2012). Once liberated from 
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the lipid droplet, fatty acids are again ligated to coenzyme A in order to be 

processed for mitochondrial oxidation. The mitochondrial outer membrane protein 

CPT1 converts fatty acyl-coas to acyl-carnitines (Eaton, 2002), which are then 

shuttled into the mitochondrial matrix through the voltage-dependent anion 

channel and the inner membrane carnitine-acylcarnitine translocase. Once inside 

the matrix, fatty acyl-carnitines are converted back to acyl-coas by CPT2 and 

finally oxidized to produce NADH, FADH2, and acetyl-coA in a process called beta-

oxidation. While CPT1 has been shown to play a key role in regulating fat oxidation 

in liver and muscle tissue, the precise mechanisms by which mitochondria 

dynamically switch between glucose to fatty acid oxidation are still unclear. A better 

understanding of fat metabolism is therefore essential to improve obesity 

treatment.  
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CHAPTER TWO: Mitochondria Bound to Lipid Droplets Have Unique 

Bioenergetics, Composition, and Dynamics That Support Lipid Droplet 

Expansion  

Abstract 

Mitochondria associate with lipid droplets (LDs) in fat-oxidizing tissues but the 

functional role of these peridroplet mitochondria (PDM) is unknown. Microscopic 

observation of interscapular brown adipose tissue reveals that PDM have unique 

protein composition and cristae structure, and remain adherent to the LD in the 

tissue homogenate. We developed an approach to isolate PDM based on their 

adherence to LDs. Comparison of purified PDM to cytoplasmic mitochondria 

reveals that (1) PDM have increased pyruvate oxidation, electron transport, and 

ATP synthesis capacities. (2) PDM have reduced beta oxidation capacity and 

depart from LDs upon tissue activation of thermogenesis and beta oxidation. (3) 

PDM support LD expansion as Perilipin 5-induced recruitment of mitochondria to 

LDs increases ATP-dependent triacylglyceride synthesis. (4) PDM maintain a 

distinct protein composition due to uniquely low fusion-fission dynamics. We 

conclude that PDM represent a segregated mitochondrial population with unique 

structure and function that supports triacylglyceride synthesis.  

Introduction 

Studies have shown that mitochondria contact lipid droplets (LDs) in tissues with 

high fatty acid storage and oxidation capacity, including brown adipose tissue 
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(Boutant et al., 2017), heart (H. Wang et al., 2013), and Type I skeletal muscle 

(Tarnopolsky et al., 2007). Furthermore, mitochondria-LD association was shown 

to be highly regulated by Perilipin5 (Plin5), a LD coat protein highly expressed in 

fat-oxidizing tissues (H. Wang et al., 2011). The high degree of regulation and 

tissue-specificity support the concept that peridroplet mitochondria (PDM) play a 

specialized role in fat metabolism. However, it remains unclear whether PDM 

promote lipid oxidation (Rambold, Cohen, & Lippincott-Schwartz, 2015), lipid 

storage (Nguyen et al., 2017; Stone et al., 2009; H. Wang et al., 2011), or both. 

In this study, we sought to determine the role of PDM in a system where a robust 

shift can occur between fat storage and oxidation. Brown adipose tissue (BAT) 

acutely turns on uncoupled lipid oxidation upon adrenergic stimulation (Barbara 

Cannon & Nedergaard, 2004). Functional specialization and segregation of 

mitochondrial subpopulations may allow BAT mitochondria to perform the 

contradictory tasks of uncoupled fatty acid oxidation and ATP generation for fatty 

acid activation by Coenzyme A (CoA) addition. However, it remains unclear 

whether functional specialization and segregation is possible in brown adipocytes 

where fusion and fission continuously equilibrate the content across the 

mitochondrial population within each adipocyte (Wikstrom et al., 2014). 

Furthermore, there are currently no established methods to isolate PDM, leaving 

their function, composition, and bioenergetics unknown.  
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In this study, we developed an approach to isolate PDM from BAT based on their 

adherence to LDs. Our results demonstrate that PDM represent a segregated 

mitochondrial subpopulation with distinct composition, bioenergetics, and 

dynamics that support triacylglyceride synthesis.  

 

Results 

Isolation of peridroplet mitochondria by differential centrifugation 

Little is currently known about peridroplet mitochondria (PDM) due to the lack of 

reliable methods to selectively isolate PDM. The tight association between 

mitochondria and lipid droplets (LDs) observed in electron micrographs 

(EMs)(Wikstrom et al., 2014) and in biochemical studies (Yu et al., 2015) led us to 

hypothesize that mitochondria-LD association could withstand mechanical cell 

disruption. To test this, we disrupted interscapular brown adipose tissue (BAT) 

using a dounce homogenizer, separated the fat layer by low-speed centrifugation, 

and co-stained it with the neutral lipid dye BODIPY 493/503 (BODIPY) and the 

mitochondrial dye MitoTracker deep red (MitoTracker)(Figure 2.1A). Super-

resolution confocal microscopy revealed numerous LDs surrounded by tubular 

MitoTracker-stained structures, suggesting that mitochondria-LD association was 

preserved in the fat layer (Figure 2.1B). Next, to separate PDM from LDs, we 

centrifuged the fat layer at high speed, a procedure previously shown to strip LD 

proteins (Ding et al., 2013). The stripped fat layer contained over 50% fewer LDs 
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with MitoTracker fluorescence (Figures 2.1C-D), suggesting that LDs were 

effectively stripped of PDM. The resulting peridroplet mitochondrial (PDM) pellet 

contained MitoTracker-positive particles and little to no BODIPY staining (Figure 

2.1E), suggesting that PDM were successfully separated from LDs. To confirm that 

PDM were not contaminated with LD remnants, we quantified the LD content under 

low magnification microscopy (Figure 2.1F-G). Low-magnification images revealed 

that PDM pellet had over 95% lower LD content compared to the fat layer (Figure 

2.1G). Furthermore, the level of LD contamination within the PDM pellet was 

similar to the LD contamination within the cytoplasmic mitochondria (CM) pellet 

isolated from the supernatant (Figures 2.1A, 2.1G). These results suggest that LDs 

were effectively removed from PDM by differential centrifugation.  

Since differential centrifugation results in relatively crude preparations, we next 

determined the mitochondrial protein content in CM and PDM fractions by mass 

spectrometry. Protein annotation using MitoCarta2.0 (Calvo, Clauser, & Mootha, 

2016) revealed that 5969 out of 10935 (54.5%) identified peptides belonged to 

mitochondrial proteins in PDM compared to 5979 out of 11812 (50.6%) in CM 

(Figure 2.1H). Furthermore, analysis of previously published BAT mitochondria 

proteomics data revealed a 46.9% enrichment of mitochondrial protein (Forner et 

al., 2009). These results suggest that mitochondrial protein enrichment in CM and 

PDM fractions were comparable and within the range of previously published 

methods.  
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Next, to determine whether CM and PDM preparations can generate a similar 

membrane potential, we stained the preparations with the membrane potential-

sensitive rosamine dye MitoTracker Red. To control for mitochondrial mass, we 

co-stained preparations with the mitochondrial protein dye MitoTracker Green 

(Cottet-Rousselle, Ronot, Leverve, & Mayol, 2011). Fluorescence microscopy 

revealed no significant differences in the MitoTracker Red-to-Green fluorescence 

ratio between CM and PDM (Figures 2.1I-J), suggesting that CM and PDM 

preparations were equally capable of generating a membrane potential.  

Peridroplet mitochondria have increased respiratory capacity  

To characterize the respiratory capacity of PDM, we measured their oxygen 

consumption rate using Seahorse XF96 extracellular flux analyzer. Isolated PDM 

and CM were loaded into different wells of the same seahorse plate and assayed 

with pyruvate and malate as fuels. Prior to the assay, we confirmed that equal 

levels of mitochondrial protein and functional mitochondria were present in CM and 

PDM preparations by mass spectrometry analysis (Figure 2.1H) and membrane 

potential imaging (Figures 2.1I-J), respectively. Furthermore, we confirmed equal 

mitochondrial mass was loaded into the XF96 flux analyzer plate by directly 

staining and imaging the wells with MitoTracker (Figures 2.2A-B).  

PDM assayed using pyruvate and malate as fuels showed a 2-fold increase in both 

ATP-synthesizing respiration (State III) and maximal respiratory capacity induced 

by uncoupling with FCCP (Maximal) when compared to CM (Figures 2.2C-E). 
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Enhanced ATP synthesis and maximal electron transport capacities in PDM were 

not limited to pyruvate oxidation since a similar increase was observed when 

assayed with the fuel succinate (Figure 2.1S).  

To determine whether increased PDM respiratory capacity is associated with 

higher capacity of respiratory enzyme complexes, we next assessed the activity of 

individual complexes in isolated mitochondria. Cytochrome c oxidase (COX) 

activity was determined by measuring oxygen consumption rate using 

TMPD/ascorbate. We injected Antimycin and rotenone at the start of the assay and 

the COX-specific inhibitor sodium azide at the end of the assay to confirm that 

TMPD/ascorbate-driven respiration was specific to COX activity. TMPD/ascorbate-

driven respiration was 68±27.5% higher in PDM compared to CM (Figures 2.2F-

G), confirming that isolated PDM have higher COX activity compared to CM.  

Next, we determined ATP synthase function in isolated mitochondria using firefly 

luciferase luminescence. We determined the optimal concentration of reagents 

and photometric measurement settings using HPLC-purified ATP standards and 

controlled for non-OXPHOS ATP synthesis using the ATP synthase inhibitor 

oligomycin. PDM had 210.4±62.8% higher rate of luminescence increase 

compared to CM (Figures 2.2H-I), confirming isolated PDM have higher ATP 

synthesis capacity compared to CM. 

Next, to determine whether higher respiratory capacity observed in isolated PDM 

can be detected in living cells, we assessed mitochondrial membrane potential 
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using the reversible membrane potential-sensitive dye tetramethylrhodamine-

ethyl-ester-perchlorate (TMRE). TMRE fluorescence intensity was not significantly 

different between CM and PDM at baseline, suggesting that increased PDM proton 

pumping by electron transport complexes may be matched by higher proton flux 

through ATP synthase. If this were the case, we reasoned that blocking ATP 

synthase will cause an acute hyperpolarization of PDM as compared to CM. 

Indeed, oligomycin treatment revealed PDM with higher TMRE fluorescence 

intensity compared to CM (Figures 2.2J-K), suggesting that PDM have higher 

proton efflux rate compared to CM. Taken together, these results suggest that 

PDM have enhanced oxidative phosphorylation capacity. 

Peridroplet mitochondria have increased levels of cytochrome c oxidase, 

ATP synthase, and super complex I+III assembly. 

We reasoned that increased electron transport and ATP synthesis capacities in 

PDM could result from increased expression levels of protein associated with 

oxidative phosphorylation. To test this, we assessed levels of each OXPHOS 

complex by Western blot analysis of complex subunits. We confirmed equal 

amounts of protein were loaded by staining Western blot membranes with the non-

specific protein dye Ponceau S (Figure 2.3A). To control for mitochondrial protein 

loading, bands were normalized to the mitochondrial marker TOM20, which did not 

vary significantly between samples (Figure 2.2S).  
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Western blot analysis revealed that PDM have 15.6±4.5% higher levels of 

cytochrome c oxidase subunit 4 (COX4) protein and 8.7±4.8% higher ATP 

Synthase subunit ɑ (ATP5a1) protein relative to CM (Figures 2.3B-C). We 

confirmed that detected differences were independent of loading and band 

saturation by performing a dilution blot and histogram analysis, respectively 

(Figures 2.2). We observed no significant differences in Complex I, Complex II, nor 

Complex III subunit levels (Figures 2.2B-C). Given the relatively small differences 

in complex protein levels, we rationalized that enhanced PDM respiratory capacity 

could be due to increased assembly of respiratory super complexes (Lapuente-

Brun et al., 2013; Rosca et al., 2008). To test this, we measured super-complex 

assembly by blue native PAGE. Remarkably, Blue native PAGE revealed 

29.5±8.2% higher levels of Complex I + Complex III super-assembly in PDM 

relative to CM (Figures 2.3D-E). These results suggest that specialized OXPHOS 

protein composition and super assembly may contribute to enhanced PDM 

respiratory capacity. 

High levels of cytochrome c oxidase and ATP synthase are preferentially 

localized to PDM 

To determine the relative levels of OXPHOS proteins in CM and PDM within intact 

brown adipocytes we next measured protein levels by immunofluorescence. We 

confirmed antibody specificity by probing a whole Western blot membrane with 

each individual antibody and exclusively detecting a single band corresponding to 
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the protein of interest (Figure 2.2S). Super-resolution confocal imaging of 

immunostained cells revealed heterogeneous distribution of OXPHOS protein in 

PDM and CM populations (Figures 2.3F-I). Subcellular distribution analysis 

revealed that mitochondria with the highest levels of COX4 and ATP synthase α 

are exclusively PDM. Remarkably, some LDs were surrounded by ATP synthase-

rich PDM, while other LDs within the same cell were surrounded by PDMs with 

lower ATP synthase levels comparable to CM. This remarkable heterogeneity may 

explain the relatively small changes we detected by Western blot analysis of the 

average protein expression of isolated CM and PDM. 

Peridroplet mitochondria have lower fatty acid oxidation capacity but 

increased TCA cycle capacity 

Our results show that PDM have enhanced OXPHOS protein levels and respiratory 

capacity. However, these results were not sufficient to determine whether PDM 

have a preference for fuel oxidation by beta oxidation or through the TCA cycle. If 

PDM are specialized for fat oxidation, we reasoned that 1. isolated PDM will have 

enhanced fatty acid oxidation capacity, 2. PDM will have enhanced levels of 

uncoupling protein 1 (UCP1), and 3. mitochondrial contact with LDs will be 

increased during cold-induced thermogenesis, when fatty acid oxidation rate is 

maximal. 

To test these predictions, we measured fatty acid-driven respiration and UCP1 

content in isolated mitochondria. Contrary to our prediction, maximal respiration 
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driven by palmitoyl-carnitine was significantly lower in PDM compared to CM 

(Figures 2.4A-B). We confirmed that PDM have reduced fatty acid oxidation 

capacity by normalizing fat oxidation capacity to pyruvate oxidation capacity 

assayed in parallel wells on the same seahorse XF96 plate (Figure 2.3S). 

Furthermore, Western blot analysis showed no difference in UCP1 levels (Figure 

2.4C), suggesting that PDM are not specialized for thermogenic fat oxidation.  

Since mitochondrial beta oxidation and TCA flux are two competing pathways 

(Garland, Shepherd, Nicholls, & Ontko, 1968), we next tested whether enhanced 

PDM respiratory capacity is supported by higher capacity for TCA cycling. To this 

end, we determined the activity of the TCA enzyme citrate synthase (CS) by 5,5′-

dithio-bis(2-nitrobenzoic acid) (DTNB) absorbance assay. DTNB reduction rate 

was 33.1±9.7% higher in isolated PDM compared to CM (Figures 2.4D-E), 

suggesting higher TCA cycle capacity. We next measured NAD(P)H levels in 

cultured primary brown adipocytes using live cell fluorescence microscopy. 

NAD(P)H levels as measured by 450nm emission were 30.8±3.5% higher in PDM 

compared to CM (Figures 2.4F-G), consistent with CS measurements (Figures 

2.4D-E). Taken together, these results suggest that enhanced ATP synthesis and 

electron transport capacity in PDM are supported by increased substrate oxidation 

through the TCA cycle.  

Mitochondria-LD contact is decreased upon activation of thermogenic fatty 

acid oxidation in vivo  
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The reduced fatty acid oxidation capacity observed in isolated PDM suggested that 

PDM are not specialized for fat oxidation. To determine the relation between PDM 

and fatty acid oxidation in vivo, we next assessed mitochondria-LD contact in BAT 

harvested from cold-adapted animals, where fatty acid oxidation is maximized to 

produce heat. If PDM play a significant role in fatty acid oxidation, we predicted 

that mitochondria-LD contact will be increased in cold-exposed mice compared to 

mice adapted to thermoneutral conditions, where fatty acids are stored in LDs. 

Contrary to our predictions, the number of mitochondria in contact with LDs was 

over 50% lower in cold-exposed mice compared to thermoneutral conditions 

(Figures 2.4H-I). Quantitative image analysis confirmed this: Mitochondria-LD 

contact area represented only 3.8±1.0% of mitochondrial perimeter in cold-

exposed mice compared to 24.7±3.7% in thermoneutral conditions (Figure 2.4J). 

To control for reduced LD surface area resulting from lipid oxidation during cold 

exposure, we quantified mitochondria-LD contact area as a proportion of LD 

perimeter (Figure 2.4K). Mitochondria-LD contact as a proportion of LD surface 

was reduced by over 75% in cold exposed animals, confirming that mitochondria-

LD contact is reduced by cold exposure. These results suggest that mitochondria-

LD contact is negatively associated with fatty acid oxidation in vivo. 

Mitochondria-lipid droplet association promotes lipid droplet expansion  

The high level of mitochondria-LD contact observed in thermoneutral conditions 

led us to hypothesize that mitochondria-LD contact plays a role in LD expansion 
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rather than oxidation. To test this, we sought to create an experimental system 

where mitochondrial association to LDs can be induced. Plin5 is a LD-coating 

protein that is uniquely capable of recruiting mitochondria to LDs (Bosma et al., 

2012; H. Wang et al., 2013) through its C-terminal region (Figure 2.5A) (H. Wang 

et al., 2011). We therefore assessed the effect of adenovirus-mediated Plin5 

overexpression on LD expansion in cultured brown adipocytes.  

To determine mitochondrial association to LDs we stained transduced cells with 

TMRE to label the mitochondrial network and BODIPY 493/503 (BODIPY) to label 

LDs. Confocal microscopy revealed that cells expressing the full version of Plin5 

that includes its mitochondrial recruiting sequence (Plin5) significantly increased 

mitochondrial recruitment to LDs relative to untransduced control cells (Figures 

2.5B-C). We confirmed the mitochondrial recruitment phenotype was not due to 

increased LD content as large areas of the cytosol remained free of LDs and 

mitochondria in cells over expressing Plin5 (Figures 2.4S, 2.5G). 

To control for Plin5 effects that are not related to mitochondrial recruitment, we 

overexpressed a truncated version of Plin5 that lacks the C-terminal mitochondrial 

recruiting sequence (Plin5∆399-463). Confocal imaging confirmed that Plin5∆399-

463 did not significantly increase mitochondrial recruitment to LDs relative to 

untransduced control cells (Figures 2.5B-C). Next, to determine the effect of Plin5-

mediated mitochondrial recruitment to LDs on bioenergetic capacity, we performed 

respirometry on intact Plin5 transduced cells. Cells expressing the full version of 
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Plin5 that contains the mitochondrial recruiting sequence had 83.2±24.0% higher 

ATP-linked respiration and 54.1±28.6% higher spare respiratory capacity 

compared to cells expressing truncated Plin5∆399-463 that lacks the 

mitochondrial recruiting sequence (Figures 2.4S). These results confirmed that 

mitochondrial recruitment to LDs by Plin5 promotes increased respiratory capacity, 

in agreement with data from isolated PDM (Figures 2.2A-C).  

Next, to determine the effect of mitochondrial recruitment on lipid accumulation, 

we quantified LD area in confocal microscopy images.  Quantitative image analysis 

revealed that cells expressing the full version of Plin5 that contains mitochondrial 

recruiting sequence (Plin5) had significantly higher LD accumulation (Figure 2.5D) 

and size (Figure 2.5E) compared to cells expressing the truncated version of Plin5 

that lacks the mitochondrial recruiting sequence (Plin5∆399-463). We confirmed 

these effects were not related to lipolysis regulation as overexpression of Plin5 and 

Plin5∆399-463 reduced lipolysis to the same extent (Figure 2.5F). These results 

suggest that mitochondrial association to LDs promotes LD expansion 

independent of lipolysis regulation.  

To determine whether this phenomenon is unique to brown adipocytes, we 

repeated this experimental series in INS1, a pancreatic beta cell line with low levels 

of endogenous Plin5 expression and lipogenic capacity (Figure 2.5G). Consistent 

with brown adipocytes, over 80% of mitochondria were recruited to LDs in INS1 

cells expressing Plin5 compared to less than 12% in Plin5∆399-463 (Figure 2.5H). 
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Furthermore, LD accumulation and size were significantly higher in INS1 cells 

expressing Plin5 compared to Plin5∆399-463 (Figures 2.5I-J). These results 

suggest that mitochondrial contact with LDs promotes the expansion of LDs in non-

adipose cell types. 

Mitochondria-lipid droplet association promotes triacylglyceride synthesis 

We reasoned that mitochondrial recruitment to LDs can expand LDs by enhancing 

the synthesis of triacylglycerides (TAGs). To test this, we assessed the effect of 

Plin5 overexpression on TAG synthesis. As before, we performed parallel 

experiments in cells expressing truncated Plin5∆399-463 that lacks mitochondrial 

recruiting sequence but preserve lipolysis regulatory function (Figure 2.4F). Cells 

were incubated with BODIPY C12 558/568 (C12), a fluorophore-conjugated fatty 

acid, and thin layer chromatography (TLC) was used to resolve cellular lipid 

species (Rambold et al., 2015). Plin5 increased C12 incorporation into TAG by 

52.1±14.3% while Plin5∆399-463 increased C12 incorporation by only 11.0±2.5% 

relative to untransduced controls (Figures 2.6A-B). To confirm C12 incorporation 

was dependent on TAG synthesis, we incubated cells with Triacsin C, a potent 

inhibitor of fatty acid esterification into TAG (Figures 2.6C-D). Triacsin C decreased 

C12 incorporation into TAG by 43.5% and increased free C12 by 28.6%, 

confirming that C12 incorporation into TAG depends on esterification.  

We reasoned that LD recruitment could promote TAG synthesis by fulfilling the 

energy requirements of ATP-dependent TAG synthesis reactions (Mashek, Li, & 
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Coleman, 2007; Prentki & Madiraju, 2012). To test this, we assessed the effect of 

the mitochondrial ATP Synthase inhibitor Oligomycin A on Plin5-enhanced TAG 

synthesis. C12 incorporation in Plin5 expressing cells was 17.8±3.6% more 

sensitive to Oligomycin inhibition compared to Plin5∆399-463 and untransduced 

controls (Figures 2.6E-F). These results suggest that mitochondrial association to 

LDs enhance TAG synthesis in a mitochondrial ATP-dependent manner. 

Peridroplet mitochondria have unique structure, fusion dynamics, and 

movement  

Mitochondria are highly dynamic organelles that continuously undergo cycles of 

fusion and fission to regulate network morphology and distribute network content 

(Chen, Chomyn, & Chan, 2005; Liesa & Shirihai, 2013; Nakada et al., 2001). We 

therefore hypothesized that PDM maintain unique functional and proteomic identity 

through distinct fusion-fission dynamics. To test this, we first assessed the 

morphology of PDM and CM in electron micrographs of mice adapted to 

thermoneutrality, where PDM are the most abundant. Mitochondria with direct 

contact to LDs had 93.2±22.9% larger cross-sectional area and 47.4±7.3% longer 

aspect ratio compared to mitochondria with no visible LD association (Figures 

2.7A-C). Analysis of internal mitochondrial structure also revealed that cristae in 

mitochondria associated with LDs were arranged in perpendicular orientation to 

the axis of mitochondria-LD interface and were 12.0±0.9% shorter and 5.4±0.8% 

wider compared to mitochondria with no visible association to LDs (Figure 2.5S). 
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To determine whether PDM structural specializations are preserved in cultured 

cells, we performed confocal microscopy in living brown adipocytes transduced 

with mitochondrially-targeted photo-activatable GFP (mtPAGFP). Transduced 

brown adipocytes were stained with TMRE to visualize the entire mitochondrial 

network. Individual mitochondria were photo-converted by 2-photon laser pulse 

and imaged immediately thereafter (Figure 2.7D). Quantitative image analysis 

confirmed that PDM are more elongated than CM in cultured cells (Figure 2.7E). 

These results suggest that PDM functional specialization is matched by 

specialized structure. 

We next assessed the fusion activity of CM and PDM in cultured brown adipocytes 

using mtPAGFP. The dilution of mtPAGFP fluorescence intensity over time reflects 

fusion of photo-activated mitochondria with non-photo-activated mitochondria. A 

150 µm2 region of the cell containing primarily PDM or CM was photo-converted 

by 2-photon laser pulse and imaged continuously at 15-minute intervals. mtPAGFP 

dilution rate was significantly slower in PDM compared to CM (Figures 7F-G), 

suggesting that PDM have reduced fusion compared to CM and decreased content 

exchange with the rest of the mitochondrial network.  

We reasoned that reduced PDM fusion could result from a reduction in one or more 

of the determinants of fusion: 1) Mitofusin (Mfn) expression, 2) mitochondrial 

membrane potential (MMP), and 3) mitochondrial motility (Twig et al., 2010). 

Western blot analysis ruled out Mfn expression as the cause of reduced fusion as 



21 

 

 

Mfn2 expression was high in PDM relative to CM (Figures 2.5S). Additionally, MMP 

analysis using the membrane potential-sensitive dye TMRE showed that PDM do 

not have reduced MMP (Figures 2.5S). To determine whether LD association 

reduces fusion by decreasing mitochondrial motility, we next quantified 

mitochondrial displacement over time in time-lapse confocal imaging. PDM 

displacement rate was significantly lower compared to CM (Figures 2.7H-I), 

suggesting that LD anchoring reduces PDM fusion by arresting motility. Taken 

together, these results suggest that PDM have reduced mitochondrial motility 

leading to decreased fusion activity that promotes their segregation from CM. 

Peridroplet mitochondria have reduced DRP1 recruitment and OPA1 

processing 

The concomitant reduction in PDM fusion activity and marked elongation led us to 

hypothesize that reduced fusion rate is matched by reduced fission activity (Chen 

et al., 2003). To assess outer membrane fission, we measured the recruitment of 

DRP1 to mitochondria by immunofluorescence (Cereghetti et al., 2008). Drp1 was 

immunolabeled in cultured cells where the mitochondrial network was labelled by 

mitochondrially-targeted DsRed (mtDsRed). Confocal imaging revealed 

significantly lower DRP1 staining on PDM compared to CM (Figures 2.8A-B), 

suggesting lower outer membrane fission activity. Next, to assess inner membrane 

fission, we measured OPA1 processing in isolated mitochondria. Proteolytic 

cleavage of the long-forms OPA1 (L-OPA1) to short-OPA1 (S-OPA1) is associated 
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with inner membrane fission (Anand et al., 2014). Western blot analysis revealed 

significantly lower levels of S-OPA1 in PDM compared to CM, suggesting lower 

inner membrane fission activity (Figures 2.8C-F). We reasoned that fission arrest 

can be a cause or a consequence of LD recruitment. To test this, we assessed 

mitochondrial LD association in cells expressing the dominant-negative DRP1 

K38A (DRP1DN)(Smirnova, Griparic, Shurland, & van der Bliek, 2001). DRP1DN 

did not enhance mitochondrial recruitment to LDs (Figures 2.8G-H), suggesting 

that fission arrest is a consequence rather than a cause of LD recruitment. Taken 

together, these results suggest that LD association reduces fission protein 

recruitment and processing that promotes PDM elongation. 

 

Discussion 

Peridroplet mitochondrial isolation by differential centrifugation 

In this study we developed an approach to isolate intact respiring PDM and 

determine their bioenergetic function for the first time. Our approach took 

advantage of the buoyancy of LDs to separate LD-bound PDM from CM. PDM 

were then purified using high-speed centrifugation, a procedure previously shown 

to strip LD-associated proteins (Figure 2.1) (Ding et al., 2013; Yu et al., 2015). 

These results raise important considerations for the interpretation of past and 

future experiments with isolated mitochondria. First, mitochondrial isolation 

protocols that eliminate lipid fraction by aspiration (Rogers et al., 2011) and/or 
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gauze filtration (Cannon & Nedergaard, 2001) may miss physiologically relevant 

changes that occur in PDM but not in CM. Second, isolation protocols that include 

an initial high-speed centrifugation step prior to low-speed centrifugation steps 

(Cannon & Nedergaard, 2001; Djafarzadeh & Jakob, 2017) may inadvertently strip 

LDs, resulting in a mixed population of CM and PDM. To our knowledge, this is the 

first report to specifically isolate intact respiring PDM from any tissue type and 

directly determine their functional role.  

PDM have specialized oxidative phosphorylation protein composition and 

capacity  

BAT mitochondria isolated by previous methods were shown to have low levels of 

ATP synthase elementary particles (Lindberg, de Pierre, Rylander, & Afzelius, 

1967) and activity (Cannon & Vogel, 1977). Our study reveals that PDM have over 

two-fold higher ATP synthesis capacity matched by enriched ATP synthase protein 

subunits when compared to CM, which may explain the relatively low levels of ATP 

synthesis reported in mitochondria isolated from BAT using previous methods. 

Consistent with higher ATP synthesis capacity, PDM were also enriched with 

cytochrome c oxidase and had increased electron transport capacity (Figure 2.3). 

We confirmed that higher respiration was not due to an artefactual difference in 

mitochondrial enrichment of PDM fraction by mass spectrometry analysis (Figure 

2.1H) and imaging of mitochondria loaded within seahorse XF96 plates (Figures 

2.2A-B). In addition, careful attention was dedicated to eliminate potential artifacts 
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due to the presence of free fatty acids. Free fatty acids can alter respiration by 1) 

providing fuel for beta oxidation, 2) acting as weak uncouplers (Y. Li, Fromme, 

Schweizer, Schöttl, & Klingenspor, 2014), and 3) activating UCP1 (Fedorenko, 

Lishko, & Kirichok, 2012). To address this, we assessed the lipid contents of CM 

and PDM (Figures 2.1F-G) and supplemented the respiratory buffer with 0.1% BSA 

to remove free fatty acids from solution as well as 1mM of the UCP1 inhibitor GDP. 

ADP- and FCCP-stimulated respiration confirmed that mitochondria were coupled 

at the start of the assay. Free fatty acids could not serve as mitochondrial fuels in 

this system because the enzymes and cofactors required for acyl-CoA and acyl-

carnitine syntheses are not present in assay buffer. Our results thus demonstrate 

that PDM represents a mitochondrial subpopulation with distinct bioenergetics and 

protein composition.  

Peridroplet mitochondria are segregated by reduced fusion-fission 

dynamics 

In every cell type where mitochondrial dynamics has been studied, mitochondria 

were shown to go through continuous cycles of fusion and fission that equilibrate 

the mitochondrial content across the mitochondrial population of the cell. We have 

previously reported that mitochondria in brown adipocytes continuously engage in 

fusion and fission activities (Wikstrom et al., 2014). The mechanism by which 

mitochondrial subpopulations can maintain separate function and composition in 

brown adipocytes was therefore unclear. Disparate mitochondrial subpopulations 
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have been previously observed in tissues where mitochondrial subpopulations are 

separated in space (Wikstrom, Twig, & Shirihai, 2009). For example, in striated 

muscle, it has been observed that subsarcolemmal mitochondria that are 

separated from interfibrillar mitochondria by the sarcomere have specialized form 

and function (Palmer, Tandler, & Hoppel, 1977). However, the brown adipocyte 

lacks the cytoplasmic subdivision that is mediated by myocyte sarcomeres and 

thus one expects fusion and fission to continuously equilibrate mitochondrial 

content across the adipocyte mitochondrial population (Wikstrom et al., 2014). Our 

results demonstrate that PDM have reduced fusion-fission dynamics that 

segregate them from the rest of the mitochondrial population (Figures 2.7F-G). 

Various evidence support that altered mitochondrial dynamics are a consequence 

rather than a cause of LD recruitment: 1) Neither fusion arrest (Boutant et al., 2017) 

nor fission arrest (Figures 2.8G-H) recruit mitochondria to LDs and 2) Mitochondrial 

recruitment to LDs by Plin5 promotes mitochondrial elongation (H. Wang et al., 

2013). This supports the conclusion that reduced mitochondrial dynamics are a 

consequence rather than a cause of LD association. Furthermore, our observation 

that PDM are stationary (Figures 2.7H-I) suggests a mechanism by which LD 

association reduces mitochondrial dynamics, as we have previously shown that 

stationary mitochondria have markedly lower probability to undergo fusion (Twig 

et al., 2008, 2010). Our results thus suggest that PDM maintain functional and 
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proteomic segregation from CM by having reduced motility and fusion-fission 

dynamics.  

Peridroplet mitochondria are not associated with fatty acid oxidation 

Recent studies have hypothesized that PDM facilitate fatty acid trafficking toward 

mitochondrial beta oxidation (Boutant et al., 2017; Rambold et al., 2015) while 

others have suggested that mitochondria-LD association enhances LD biogenesis 

and thereby protects mitochondria from lipotoxicity (Nguyen et al., 2017; Stone et 

al., 2009, p. 2; H. Wang et al., 2011). In this study we employed brown adipose 

tissue, a system that robustly shifts from LD expansion under thermoneutral 

conditions to lipid oxidation under cold/adrenergic stimulus. If PDM facilitate fat 

oxidation, we reasoned mitochondria-LD association will increase during cold-

induced thermogenesis, when fatty acid oxidation rate is maximal. However, 

contrary to the hypothesis, mitochondrial association with LDs was decreased by 

cold-exposure (Figures 2.4H-K). These results are consistent with the previously 

published observation that mitochondrial protein content is reduced in LDs isolated 

from BAT of cold-adapted mice compared to mice in thermoneutral environment 

(Yu et al., 2015). Our analyses of isolated mitochondria confirmed that PDM have 

lower fatty acid oxidation capacity and higher TCA cycle capacity compared to CM 

(Figures 2.4A-G). Taken together, these results support the conclusion that PDM 

are not specialized for lipid oxidation in BAT. 

Mitochondria-lipid droplet interaction enhances lipid droplet expansion 
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The high level of mitochondria-LD contact observed in BAT under thermoneutral 

conditions led us to hypothesize that PDM play a role in LD expansion. To test this, 

we induced mitochondrial recruitment to LDs using adenoviral-mediated Plin5 

overexpression, which has been shown to recruit mitochondria to LDs in multiple 

cell and tissue types (Bosma et al., 2012; H. Wang et al., 2011, 2013). Importantly, 

we developed a system in which the specific effects of mitochondrial recruitment 

can be differentiated from other Plin5 effects, such as lipolytic regulation. Our 

2.results show that mitochondrial recruitment to LDs doubled the size of LDs 

(Figure 2.5). Furthermore, the capacity of PDM to promote the incorporation of free 

fatty acids into TAG was dependent on mitochondrial ATP synthesis (Figure 2.6). 

This observation supports the conclusion that PDM enhance LD expansion by 

providing ATP to the ATP-demanding process of acyl-CoA synthesis and lipid 

cycling (Prentki & Madiraju, 2012). In addition, the increased TCA cycle capacity 

we observed suggests that PDM may support LD expansion by providing citrate 

for de novo lipogenesis. Taken together, our results thus support the conclusion 

that PDM support LD expansion rather than oxidation. 

We suggest that increased mitochondrial recruitment to LDs may be part of a 

generalized adaptive response in physiological conditions that require LD 

expansion, such as post-prandial lipid synthesis and storage. PDM-mediated LD 

expansion may also play a role in muscle and liver injury from lipotoxicity in 

conditions of nutrient excess, such as obesity and hyperlipidemia. A better 
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understanding of PDM and LD biology may therefore be important for developing 

new therapies for lipotoxic tissue injury and insulin resistance. Animal models in 

which mitochondria-LD association can be specifically modulated will be 

necessary to resolve such questions in future studies.   

Limitations of study 

This study is the first to isolate intact respiring PDM and determine their unique 

composition and bioenergetics. However, our study has several limitations. 

Limitations of our PDM isolation approach include: 1. Mitochondrial isolation by 

differential centrifugation results in relatively crude preparations contaminated with 

other organelles and cellular compartments. Mass spectrometry analysis of CM 

and PDM preparations revealed that approximately half of the proteins present in 

CM and PDM preparations were mitochondrial (Figure 2.1H), in agreement with 

previously published reports (Forner et al., 2009). 2. Mitochondrial isolation by 

differential centrifugation pools all PDM into a single pellet. As such, inter-

mitochondrial heterogeneity (Figures 2.3F-I) is lost in subsequent biochemical and 

functional assays, which may lead to under-estimation of differences between CM 

and PDM populations (Figures 2.3A-C). 3. PDM isolation by differential 

centrifugation may preferentially select for PDM attached to larger LDs with higher 

buoyancy. Small LDs with insufficient buoyancy could potentially contaminate the 

supernatant and CM pellet and lead to further under-estimation of the differences 

between isolated CM and PDM properties. 4. Our method used high-speed 
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centrifugation to strip PDM from LDs, a procedure which may alter their function. 

However the close agreement between our proteomic and bioenergetic data in 

living cells and isolated mitochondria (Figures 2.2-3) suggests that isolated PDM 

preserved the metabolic phenotype observed in intact cells. 

Figures  

 Figure 2.1. Isolation of peridroplet mitochondria by differential 

centrifugation. 

A. Schematic representation of peridroplet (PDM) and cytoplasmic (CM) 

mitochondrial isolation from interscapular brown adipose tissue (BAT). BAT was 

dissected from mice and homogenized with glass-Teflon dounce homogenizer. 

Low-speed centrifugation separated the fat layer containing PDM from supernatant 

containing CM. High-speed centrifugation stripped PDM from lipid droplets (LDs) 

and pelleted CM mitochondria from the supernatant. Note that some BAT 

mitochondrial isolation protocols discard the fat layer and/or begin with high-speed 

centrifugation step. 

B-E. PDM are stripped from LDs by high-speed centrifugation. 

B-C. Super-resolution confocal images of the fat layer before and after high-speed 

centrifugation. LDs were marked by the neutral BODIPY 493/503 fluorescent dye 

(BODIPY) and mitochondria by MitoTracker deep red dye (MitoTracker). Note the 

tubular structures staining positively for MitoTracker on LDs. 
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D. Quantification of LDs with MitoTracker staining in the fat layer pre- and post-

stripping by high-speed centrifugation. 11,744 LDs were assessed in total. *** p < 

0.0001. 

E. Super-resolution confocal image of PDM pellet separated from fat layer by high-

speed centrifugation.  

F-G. Low-magnification (20x) images of the fat layer, PDM pellet, and CM pellet. 

LD content was assessed by BODIPY staining. 5-6 technical replicates per group. 

N = 3 independent isolations. ns p>0.05, *** p < 0.0001. One-way ANOVA with 

Tukey post-test. 

H. Mass spectrometry analysis of relative mitochondrial protein content of CM and 

PDM preparations.  

I-J. Analysis of CM and PDM membrane potential by fluorescence microscopy of 

CM and PDM double-stained with the membrane potential-sensitive dye 

MitoTracker Red and the mitochondrial protein dye MitoTracker Green. N = 15-22 

images per group from 3 independent isolations. ns p>0.05. 
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Figure 2.2. Peridroplet mitochondria have enhanced bioenergetic capacity. 

A-I. Peridroplet (PDM) and cytosolic (CM) mitochondria isolated from brown 

adipose tissue (BAT). 

A. Fluorescence microscopy images of seahorse respirometry plate wells 

containing isolated CM and PDM stained with MitoTracker Red.  

B. Quantification of MitoTracker Red fluorescence intensity (F.I.) in Seahorse wells 

loaded with CM or PDM. 5-7 wells quantified per condition.  

C. Representative traces of oxygen consumption rates (OCRs) of isolated PDM 

and CM driven with pyruvate+malate. ADP, Oligomycin, FCCP, and Antimycin 

were sequentially injected to assess mitochondrial respiratory states. 4-6 technical 

replicates per group.  

D. Quantification of OCR at different mitochondrial respiratory states in 

representative experiment. State II quantifies respiration driven proton leak (no 

ATP synthesis), State III quantifies respiration driven by ATP synthesis, and 

maximal respiration quantifies maximal electron transport activity induced by the 

chemical uncoupler FCCP. 6 technical replicates per group.  

E. Quantification of mitochondrial respiratory states in N = 8 independent 

experiments. For each individual experiment, average OCR values of CM and 

PDM were normalized to the average OCR of all mitochondria (see Quantification 

and Statistical Analysis for complete equations).  

F-G. Cytochrome C oxidase activity in PDM and CM isolated from BAT. 
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F. Representative traces of oxygen consumption rate (OCR) of isolated PDM and 

CM driven with the cytochrome c oxidase-specific substrates TMPD+Ascorbate. 

Rotenone and Antimycin were injected in the beginning of the assay to extinguish 

cytochrome c reduction by Complex I and Complex III. The COX-specific inhibitor 

sodium azide was injected at the end of the assay to control for non-COX oxygen 

consumption. 5 technical replicates per group.  

G. Quantification of COX activity in N = 4 independent isolations. Data were 

normalized as in E. 

H-I. ATP synthase activity in PDM and CM isolated from BAT. 

H. Representative traces of luciferase luminescence assay in isolated 

mitochondria normalized to baseline. ATP synthesis rates were determined by the 

rate of luminescence gain.  

I. Quantification of ATP synthase activity in N = 4 independent isolations. Data 

were normalized as in E. 

J-K. Confocal imaging of living cultured brown adipocytes stained with membrane 

potential-sensitive dye TMRE.  

J. Confocal imaging before and after addition of the ATP synthase inhibitor 

oligomycin. Bright field image was used to identify LDs. TMRE images were 

pseudo-colored for quantitative display (see calibration bar in top left). Note that 

PDM had higher fluorescence than CM after oligomycin treatment. White dashed 
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circles denote LDs, white N denotes the nucleus, and white square denotes 

zoomed region. 

K. Quantification of TMRE fluorescence intensity in oligomycin-treated brown 

adipocytes. 159 mitochondria were assessed in total. N = 33 cells collected in 6 

independent experiments.  

Data are expressed as means ± SEM. ns p>0.05, * p< 0.05, ** p < 0.001, *** p < 

0.0001. 

See also Figure 2.1S.  
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Figure 2.3. Peridroplet mitochondria have increased levels of cytochrome c 

oxidase, ATP synthase and super complex I+III assembly. 

A-C. Western blot analysis of Peridroplet (PDM) and cytosolic (CM) mitochondria 

isolated from brown adipose tissue (BAT). 

A. Western blot of isolated CM and PDM stained with the dye Ponceau S for total 

protein loading. 

B. Western blot probed with antibodies of OXPHOS complex subunits I-V (CI-CV) 

and TOM20 as a loading control. 

C. Quantification of OXPHOS complex subunits normalized to TOM20 loading 

control in N = 4-7 independent isolations. For each individual experiment, average 

values detected in CM and PDM were normalized to the average protein subunit 

levels of all mitochondria (see Quantification and Statistical Analysis for complete 

equations). 

D-E. Western blot of Blue Native PAGE of PDM and CM isolated from BAT. 

D. Western blot of assembled complex I and complex III in isolated mitochondria. 

E. Quantification of complex III assembled into I+III supercomplexes relative to 

total complex III. N = 5 independent isolations. Data were normalized as in C. 

F-I. Super-resolution confocal imaging of fixed cultured brown adipocytes (no 

adrenergic stimulation). 

F. Brown adipocytes immunostained for cytochrome c oxidase subunit 4 (COX4). 

Bright field image was used to identify LDs and TOM20 immunostaining was used 
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to mark the mitochondrial network. White dashed circles denote LDs, white N 

denotes the nucleus, and white square denotes zoomed region. 

G. Quantification of COX4 distribution in brown adipocyte mitochondria. 490 

mitochondria were assessed in total. N = 22 cells collected in 3 independent 

experiments.  

H. Brown adipocytes immunostained for ATP Synthase. Bright field image was 

used to identify LDs and TOM20 immunostaining was used to mark the 

mitochondrial network. White dashed circles denote LDs, white N denotes the 

nucleus, and white square denotes zoomed region. 

I. Quantification of ATP Synthase distribution in brown adipocyte mitochondria. 507 

mitochondria were assessed in total. N = 20 cells collected in 4 independent 

experiments.  

Data are expressed as means ± SEM. * p< 0.05, *** p < 0.0001. 

See also Figure 2.2S.  
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Figure 2.4. Peridroplet mitochondria have decreased fatty acid oxidation 

capacity and mitochondria-LD contact is decreased upon activation of 

thermogenic fatty acid oxidation in vivo.  

A. PDM have lower fatty acid oxidation capacity. Representative quantification of 

maximal palmitoyl-carnitine driven oxygen consumption rate (Max OCR) in 

isolated peridroplet (PDM) and cytoplasmic (CM) mitochondria. 4-6 technical 

replicates per group. 

B. Quantification of palmitoyl-carnitine oxidation capacity. N = 5 independent 

experiments. For each individual experiment, average OCR values of CM and 
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PDM were normalized to the average OCR of total mitochondria (see 

Quantification and Statistical Analysis for full equations).  

C. UCP1 protein is similarly abundant in PDM and CM. Western blot analysis of 

UCP1 in CM and PDM. N = 3 independent mitochondrial isolations. Data were 

normalized as in B. 

D-E. PDM have higher activity of the TCA cycle enzyme Citrate Synthase.  

D. Representative traces of citrate synthase DTNB absorbance assay in isolated 

mitochondria normalized to baseline. Citrate synthase activity was determined for 

CM and PDM by the rate of absorbance gain.  

E. Quantification of citrate synthase specific activity. N = 4 independent 

mitochondrial isolations. Data were normalized as in B. 

F-G. PDM have increased NAD(P)H content.  

F. Confocal image of NAD(P)H fluorescence in living cultured brown adipocytes. 

Image was pseudo-colored for quantitative display (see calibration bar in top left). 

Note the high level of NAD(P)H in PDM. 

G. Quantification of NAD(P)H level. N = 24 cells imaged in 6 independent 

experiments. CM and PDM fluorescent intensities (F.I.) were normalized to 

average cell F.I. for each individual cell. 

H. Electron micrographs (EMs) of BAT harvested from mice adapted to 

thermoneutral conditions (28°C), where fatty acids are stored in lipid droplets, and 

cold environment (6°C), where thermogenic fatty acid oxidation is robustly 
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increased. Blue lines highlight mitochondrial perimeter and red lines highlight 

overlap between mitochondria and lipid droplet border.  

I-K. Mitochondria in contact with lipid droplets were quantified by count, % 

mitochondrial perimeter and % lipid droplet perimeter. N = 10 EMs per condition.  

Data are expressed as means ± SEM. ns p>0.05, * p< 0.05, ** p < 0.001, *** p < 

0.0001. 

See also Figure 2.3S.  
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Figure 2.5. Mitochondria-lipid droplet association promotes lipid droplet 

expansion.  
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A. Schematic representation of Perilipin5 (Plin5) domains: the conserved perilipin 

domains PAT1 and PAT2, the ATGL-binding domain responsible for lipolysis 

regulation, and the mitochondrial recruiting sequence. 

B. Super-resolution confocal images of living brown adipocytes untransduced 

(control), transduced with the full-length Plin5 that contains mitochondrial recruiting 

sequence (Plin5), and transduced with truncated Plin5 that lacks the mitochondria 

recruitment sequence (Plin5∆399-463). Mitochondria are marked by TMRE 

staining and lipid droplets (LDs) by BODIPY 493/503. Note the increased lipid 

droplet (LD) mass and mitochondrial recruitment in Plin5-transduced cells.  

C. Quantification of mitochondrial recruitment to LDs assessed as the area of 

mitochondria within 0.5 µm of LD border. N = 14-24 cells analyzed per group from 

4 independent experiments.  

D. Quantification of LD mass by cross-sectional area of BODIPY 493/503 

normalized to cell area. N = 17-33 cells per group from 4 independent experiments.  

E. LD size distribution assessed by cross-sectional area of individual LDs. N = 302-

489 LDs per group from 4 independent experiments.  

F. Quantification of lipolysis by glycerol release assay.  N = 3 independent 

experiments. For each individual experiment, average values of CM and PDM 

were normalized to the average values of total mitochondria (see Quantification 

and Statistical Analysis for full equations).  
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G. Super-resolution confocal images of living INS1 pancreatic beta cell line 

untransduced (control), transduced with Plin5, and Plin5∆399-463 and stained 

with TMRE to mark mitochondria and BODIPY 493/503 to mark LDs. Note the 

increased LD mass and mitochondrial recruitment in Plin5. 

H. Quantification of mitochondrial recruitment to LDs assessed as the area of 

mitochondria within 0.5 µm of LD border. N = 12-20 cells analyzed per group from 

3 independent experiments.  

I. Quantification of LD mass by cross-sectional area of BODIPY 493/503 

normalized to cell area. N = 13-19 cells per group from 3 independent experiments.  

J. LD size distribution assessed by cross-sectional area of individual LDs. N = 226-

344 LDs per group from 3 independent experiments. 

Data are expressed as means ± SEM. ns p>0.05, * p< 0.05, ** p < 0.001, *** p < 

0.0001. 

See also Figure 2.4S.  

  



44 

 

 

 



45 

 

 

Figure 2.6. Mitochondria-lipid droplet association promotes triacylglyceride 

synthesis. 

A. Representative thin layer chromatography (TLC) of cellular lipids extracted from 

cultured brown adipocytes untransduced (control), transduced with the full-length 

Plin5 that contains mitochondrial recruiting sequence (Plin5), and truncated Plin5 

that lacks the mitochondria recruitment sequence (Plin5∆399-463). Cells were 

incubated with BODIPY C12 558/568 (C12) overnight to assess triacylglyceride 

(TAG) synthesis. The mobility of fatty acids species from loading origin is 

determined by relative polarity, with TAG migrating the highest.  

B. Quantification of TAG from N = 3 independent experiments. Data were 

normalized to control for each individual experiment.  

C-D. TLC of cultured brown adipocytes incubated with C12 with or without the fatty 

acid esterification inhibitor Triacsin C (red). In histogram, note the decrease in TAG 

and increase in Free C12 induced by Triacsin C. 

E. Representative TLC of cultured brown adipocytes incubated with C12 with or 

without the mitochondrial ATP synthase inhibitor oligomycin.  

F. Quantification of TAG synthesis dependent on mitochondrial ATP from N = 3 

independent experiments. Mitochondrial ATP-dependent TAG synthesis was 

calculated as the difference in TAG between oligomycin-treated and untreated 

cells.  

Data are expressed as means ± SEM. * p< 0.05, ** p < 0.001. 
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Figure 2.7. Peridroplet mitochondria have unique structure, fusion-fission 

dynamics, and motility.  

A-C. Electron micrograph (EMs) of BAT harvested from mice adapted to 

thermoneutral conditions (28°C), where peridroplet mitochondria (PDM) are most 

abundant. Red lines highlight PDM and blue lines highlight cytoplasmic 

mitochondria (CM). Note the elongation of PDM. Mitochondrial size and shape 

were quantified in N = 22 – 34 mitochondria from 10 EMs per group.  

D-E. Confocal microscopy of living cultured brown adipocytes.  

D. Confocal images of brown adipocytes transduced with mitochondrially-targeted 

photo-activatable GFP (mtPAGFP) stained with TMRE to label the mitochondrial 

network. mtPAGFP in single mitochondria (white squares) were sequentially 

photo-converted and imaged immediately. Filled grey circles denote lipid droplets.  

E. Quantification of mitochondrial shape, as delineated by mtPAGFP. N = 47 

mitochondria from 4 independent imaging experiments.  

F-G. Mitochondrial fusion assay image and quantification in living cultured brown 

adipocytes. Brown adipocytes transduced mtPAGFP were stained with TMRE to 

label the mitochondrial network. White dashed circles denote LDs and white N 

denotes the nucleus. mtPAGFP was photo-converted in a small region of the cell 

(white squares) and its fluorescence intensity tracked over time. The dilution of 

mtPAGFP fluorescence intensity over time results from fusion between activated 

mitochondria with non-activated mitochondria. N = 5 cells per group imaged in 3 
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independent experiments. Data were normalized to baseline and statistically 

analyzed by Two-Way ANOVA for repeated measures with Bonferroni post-test. 

H-I. PDM have reduced motility compared to CM. 

H. Psudo-colored confocal images of brown adipocyte at two different time points 

(red and green). Merged image of two time points reveals immobile mitochondria 

(yellow) and mobile mitochondria that change position over time (red and green). 

White dashed circles denote LDs, white N denotes the nucleus, and white dashed 

square denotes zoomed region. Note the reduced mobility of PDM compared to 

CM. 

I. Quantification of mitochondrial motility. Mitochondrial motility was quantified in 

time-lapse images as the percent of area displaced over a period of 10 seconds. 

For each individual cell, CM and PDM motility values were normalized to the 

average motility value of all mitochondria in the cell. N = 15 cells images in 3 

independent experiments.  

Data are expressed as means ± SEM. * p< 0.05, *** p <0.0001. 

See also Figure 2.5S. 
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Figure 2.8. Peridroplet mitochondria have reduced DRP1 recruitment and 

OPA1 processing. 

A. Confocal image of fixed cultured brown adipocytes immunolabeled for the 

mitochondrial fission protein DRP1. LDs were identified by bright field images and 

the mitochondrial network was marked with mitochondrially-targeted DsRed 

(mtDsRed). Note the low levels of DRP1 recruitment to PDM (white arrows).  

B. Quantification of DRP1 associated with CM and PDM. DRP1 association was 

quantified as puncta area divided by mitochondrial area. In each individual cell, 

DRP1 association to CM and PDM values were normalized to the average of the 

entire cell. N = 14 cells per group imaged in 3 independent experiments.  

C-F. Western blot analysis of the mitochondrial inner membrane protein OPA1 in 

isolated PDM and CM. Proteolytic cleavage of the long-forms OPA1 (L-OPA1) to 

short-OPA1 (S-OPA1) is associated with inner membrane fission. Densitometry of 

L-OPA1 and S-OPA1 in PDM and CM are shown in representative histogram. 

E-F. Quantification of total OPA1 and S-OPA1 in CM and PDM. N = 6-7 

independent mitochondrial isolations.  

G. Confocal images of living primary brown adipocytes transduced with DRP1-

dominant negative (DRP1DN) and transduction control. LDs were identified by 

bright field images and the mitochondrial network was marked with TMRE. 

H. Fission arrest by DRP1 dominant negative (DRP1DN) expression does not 

recruit mitochondria to LD surface compared to transduction control. Mitochondrial 
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recruitment was assessed as the area of mitochondria within 0.5 µm of LD border. 

N = 10 cells analyzed per group.  

Data are expressed as means ± SEM. ns p> 0.05, ** p < 0.001, *** p <0.0001. 
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Supplemental Figures 

 

Figure 2.1S, related to Figure 2.2. 

Quantification of respiratory states driven by succinate/rotenone in cytoplasmic 

(blue) and peridroplet (red) mitochondria. State III quantifies respiration driven by 

ATP synthesis and maximal respiration quantifies maximal electron transport 

activity induced by the chemical uncoupler FCCP. 6 technical replicates per group. 

N = 7 independent isolations. For each individual experiment, average OCR values 

of CM and PDM were normalized to the average OCR of all mitochondria (see 

Quantification and Statistical Analysis for complete equations). Data are 

expressed as means ± SEM. *** p < 0.0001. 
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Figure 2.2S, related to Figure 2.3. 

A. TOM20 densitometry from Western blot analysis of isolated mitochondria. N = 

4 independent isolations. Experiment normalized data are expressed as means ± 

SEM. ns p>0.05. 

B. TOM20 densitometry normalized to Ponceau S staining of SDS-PAGE blots of 

isolated mitochondria. N = 4 independent isolations. Experiment normalized data 

are expressed as means ± SEM. ns p>0.05. 
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C. Dilution Western blot of isolated mitochondria. One microgram of CM was 

compared to 2 microgram PDM (PDM 2X), 1 microgram of PDM (PDM 1X), 0.5 

micrograms of PDM (0.5X), and saturating signal intensity.  

D. Quantification of COX4/TOM20 ratio at different dilutions. Note that 

COX/Tom20 ratio is elevated in PDM independent of the amount of protein loaded.  

E-F. Linescan histogram of COX4 immunostained band in isolated mitochondria 

subjected to western blot analysis compared to saturating signal intensity. Note 

that COX4 band did not exceed saturation (255 A.U. in 8-bit image). 

G. Full western blot membrane of COX4 and ATP synthase antibodies used for 

immunofluorescence experiments. Both COX4 and ATP synthase antibodies 

produced robust bands at or near the predicted molecular weights (37 kDa and 53 

kDA, respectively). There were moderate faint bands above 150 kDa in ATP 

synthase blot likely representing multimers that were not fully denatured by SDS. 
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Figure 2.3S, related to Figure 2.4. 

Maximal respiration fueled by pyruvate normalized to maximal respiration fueled 

by palmitoyl-carnitine (MaxPyr/MaxPC) in isolated cytoplasmic (CM) and peridroplet 

(PDM) mitochondria. Fuels were provided to the exact same mitochondrial 

preparations assayed on parallels wells in same seahorse plate. N = 4 independent 

experiments with 4-6 technical replicates per group. Experiment normalized data 

are expressed as means ± SEM. ** p < 0.001. 
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Figure 2.4S, related to Figure 2.5. 

A. Confocal image of brown adipocyte expressing the full length Plin5, which 

includes mitochondrial recruiting sequence. High contrast image was used to 

delineate the cell borders (white striped lines). Note that there are several empty 

cytoplasmic spaces (white arrows).  

B-D. Seahorse respirometry in cultured brown adipocytes. 

B. Representative trace of oxygen consumption rate (OCR) or cultured brown 

adipocytes expressing full-length Plin5, which includes the mitochondrial recruiting 

sequence, and truncated Plin5∆399-463, which lacks the mitochondrial recruiting 

sequences as a control. Oligomycin, FCCP, and Antimycin were sequentially 
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injected to assess ATP-linked respiration and spare respiratory capacity. 4-6 

technical replicates per group. Data are expressed as means ± SEM. 

C. Quantification of ATP-linked respiration in N = 3 independent experiments. 

Experiment normalized data are presented as means ± SEM. ** p<0.001, 

D. Quantification of spare respiratory capacity in N = 3 independent experiments. 

Experiment normalized data are presented as means ± SEM. * p<0.05. 

E. Controlling for mitochondrial mass. Quantification of mitochondrial mass in cells 

used for seahorse analysis by MitoTracker staining. ns p > 0.05. 
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Figure 2.5S, related to Figure 2.7. 

A-C. Cristae morphology analysis of peridroplet (PDM) and cytoplasmic (CM) 

mitochondria in electron micrographs of BAT harvested from mice adapted to 

thermoneutral environment (28°C), where PDM are most abundant. Note the 

uniform stacks of short thick cristae in PDM that are arranged in perpendicular 

orientation to the axis of mitochondria-LD interface.   

D-E. Western blot analysis of Mitofusin2 (Mfn2) in isolated PDM and CM. N = 7 

independent mitochondrial isolations. For each individual experiment, average 

values of CM and PDM were normalized to the average OCR of all mitochondria 

(see Quantification and Statistical Analysis for complete equations). Data are 

presented as means ± SEM. 

F-I. Imaging of the membrane potential-sensitive dye TMRE.  N = 22 cells images 

in 4 independent experiments. CM and PDM fluorescent intensities (F.I.) were 
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normalized to average cell F.I. for each individual cell. Data are presented as 

means ± SEM. ns p>0.05. 
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CHAPTER THREE: Materials and Methods 

Part One: Detailed Protocol for Isolation of Lipid Droplet Bound Mitochondria 

from Brown Adipose Tissue  

Sample collection ● TIMING 1-2 h 

1. Dissect inter-scapular brown adipose tissue (BAT) from 6 male C57bl/6 mice and 

immediately place in ice-cold PBS. The number of mice needed for effective 

PDM isolation varies according to tissue lipid content. A minimum amount of lipid 

content is necessary in order to effectively collect a fat cake (see below). Fewer 

animals can be used if mice have higher lipid content due to age, diet, or genetic 

manipulation. Euthanize mice one-by-one using isofluorance or cervical 

decapitation protocol approved by Institutional Guidelines for Animal Care in 

compliance with U.S. Public Health Service Regulation. Exsanguinate mice using 

syringe attached to 18.5G needle prior to BAT isolation to minimize blood cell 

contamination.  

2. Clean connective tissue, muscle, and white adipose tissue from BAT using 

dissection microscope. 

3. Weigh pooled BAT tissue and mince into ~2mm pieces with scissors or razor. 

Re-suspend pieces in 10:1 volume:weight ice-cold Sucrose-HEPES-EGTA buffer 

supplemented with BSA (SHE+BSA; 250mM sucrose, 5mM HEPES, 2mM 

EGTA, 2% fatty acid-free BSA (EMD Millipore 126575), pH 7.2). 

Tissue and Cell Disruption ● TIMING 10 min 

4. Disrupt tissue with 9-10 strokes in ice-cold glass/Teflon dounce homogenizer 

until the liquid appears homogenous and the dounce head moves smoothly 
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through the tube. CRITICAL: all tubes and materials must be ice-cold at the 

beginning of the isolation and remain ice-cold throughout protocol. Do not use 

detergent to clean dounce homogenizer and/or cell lysis. For samples with higher 

content of connective tissue, use glass-glass loose dounce as an initial 

homogenization step.  

Separating fat cake by low-speed centrifugation ● TIMING 20 min 

5. Transfer homogenate into ice-cold 50mL falcon tube (Corning) and centrifuge 

900 x g for 10 min at 4ºC in Sorvall ST 16R (thermo) with TX-200 swinging 

bucket rotor. CRITICAL: If using swigging bucket centrifuge, measure the precise 

distance between rotor center and the center of mass of liquid homogenate in the 

tube in horizontal swinging position in order to correctly calculate RPM 

conversion. 

2

1,000

rpm
 * (mm) radius *12.1 (g) rcf 








=  

6. Carefully pour supernatant (Fraction 2) into a new ice-cold falcon tube so as to 

leave behind fat cake (Fraction 1) and debris pellet in the original tube (Figure 

3.2). Keeping the original tube horizontal, scrape the Fraction 1 into a second 

ice-cold falcon tube and re-suspended in SHE+BSA buffer. Discard original 

falcon tube containing pellet unbroken cells, nuclei, and debris. CRITICAL: it is 

critical that there is enough sample to generate a solid fat cake for this 

procedure. 

7. Repeat this step once more to pellet residual insoluble debris. CRITICAL: 

Fractions 1 and 2 must be completely cleared of debris prior to high speed 
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centrifugation steps. Perform additional slow-speed centrifugation speed if 

necessary. If residual lipid layer is present in Fraction 2 after second slow spin, 

discard top 1mL phase. Alternatively, submerge a gel-loading tip under lipid layer 

to transfer Fraction 2 to a fresh tube.  

Separating CM and PDM by high-speed centrifugation ● TIMING 1.5 h 

8. Transfer purified Fraction 1 and Fraction 2 to 2mL Eppendorf tubes and 

centrifuge at 10,000 x g for 10 min at 4ºC in microfuge (Thermo). Pellets will now 

contain peridroplet (PDM) and cytoplasmic mitochondria (CM, Figure 3.3). 

9. Following centrifugation, discard the lipid layer and supernatant and gently re-

suspend mitochondrial pellets in ice-cold SHE+BSA buffer: Use P1000 pipette tip 

to physically scrape lipid layer and gently evacuate residual lipids before 

removing supernatant. Once supernatant is evacuated, gently resuspend pellet in 

200uL SHE+BSA and transfer all resuspended CM pellets into a single fresh ice-

cold tube. Repeat with resuspended PDM pellets. CRITICAL: There should 

minimal lipid content in samples from Fraction 2. The presence of large amounts 

of lipid in Fraction 2 will cause CM to be contaminated by PDM. Refer to the 

steps above to optimize slow centrifugation steps to minimize lipid content of 

Fraction 2.  

10. Repeat high speed centrifugation step once more with the same settings to 

remove residual lipids and non-mitochondrial contents. 

11. Following the second high speed centrifugation, remove supernatant. There 

should be no visible lipid layer at this step. Perform additional centrifugation 

steps as needed. Gently re-suspend mitochondrial pellets in ice-cold SHE buffer 
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without BSA and determine protein concentration by BCA assay (Thermo). When 

re-suspending pellet in buffer, aim for a concentration of ~10ug/uL.   

CRITICAL: use SHE buffer without BSA for protein determination. BSA will skew 

results of BCA assay.  

Respirometry ● TIMING 1 h 

12. Load Cartridge with 16.5uL MAS+ADP in Port A, 17.3uL  MAS+Oligomycin in 

Port B, 18.5uL MAS+FCCP in Port C, 20uL MAS+AA in Port D and begin 

calibration in seahorse instrument.  

13. Combine 2-4 ug mitochondria with 20uL MAS+PM, MAS+SR, and MAS+PC and 

seed each individual well in XF96 plate using P20 pipette. 

Centrifuge the plate at 2,000 x g for 5 min at 4C using plate carrier rotating 

buckets. CRITICAL: turn OFF centrifuge break and let buckets slow down 

independently.  

14. Add 115uL MAS+GDP using multichannel pipette at a 45° angle to the top of well 

chamber and immediately begin run. 

15. Mix Measure Delay times appear in appendix. 

Data Analysis ● TIMING 1 h 

16. Export Point-to-point oxygen consumption rates (OCRs) of individual wells from 

Seahorse instrument.  

17. In Microsoft Excel, perform the following calculations for each individual well. 

Antimycin-resistant respiration is subtracted from other values to exclude non-

OXPHOS OCR. 
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a. State II: Subtract minimal OCR value following Antimycin injection from 

minimal OCR value following Oligomycin injection. 

b. State III: Subtract minimal OCR value following Antimycin injection from 

maximal OCR value following ADP injection. 

c. Maximal: Subtract minimal OCR value following Antimycin injection from 

maximal OCR value following FCCP injection.  

Quality control ● TIMING VARIABLE 

18. To assess the quality of isolated mitochondria Option A describes measuring the 

lipid content of isolated mitochondria by fluorescence microscopy. Option B 

describes measuring relative mitochondrial protein content by biochemical 

techniques. Option C describes measuring mitochondrial function by membrane 

potential analysis. 

(A) Measurement of mitochondria and LD content by fluorescence microscopy 

i. Combine 1 uL of isolated mitochondria with 1uL Imaging solution A. Place 

1 uL of solution on a #1.5H coverglass and cover with an additional 

coverglass. 

ii. Place the coverglass on microscope stage and image BODIPY using 

488nm laser excitation and 500-550 absorbance. Using a separate track, 

image MitoTracker with 633nm excitation and 650-700 absorbance. Use 

20x lens for low magnification imaging of LD content. 

(B) Assessment of mitochondrial content. 

i. Combine 1-10 ug isolated mitochondria with protease inhibitors and boil 

at 95C for 5 min. Run and transfer gel as specified by gel apparatus 
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manufacturer. Probe for the relative content of mitochondrial markers 

such as Tom20 or VDAC relative to contaminant from nuclear, ER, and 

cytoplasmic compartments. Alternatively, evaluate mitochondrial content 

by mass spectroscopy proteomic analysis using MitoCarta 2.0 to estimate 

mitochondrial protein content.  

(C) Assessment of mitochondrial function by membrane potential imaging. 

i. Combine 1 uL of isolated mitochondria with 1uL Imaging solution B. Place 

1 uL of solution on a #1.5H coverglass and cover with an additional 

coverglass. 

ii. Place the coverglass on microscope stage and image MitoTracker green 

using 488nm laser excitation and 500-550 absorbance. Using a separate 

track, image MitoTracker Red with 633nm excitation and 650-700 

absorbance.  

iii. Mitotracker Red is sensitive to real time changes in membrane potential 

while MitoTracker Green is not sensitive, as it is a cumulative 

mitochondrial protein dye. Therefore, functional mitochondria will stain 

with both Green and Red while mitochondria with reduced membrane 

potential will only stain green.  
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Figures 

 
Figure 3.1. Schematic representation of peridroplet mitochondrial (PDM) isolation 

procedure.  

Interscapular brown adipose tissue (BAT) was dissected from mice and homogenized with 

glass-Teflon dounce homogenizer. Low-speed centrifugation separated fat cake 

containing PDM from supernatant containing cytoplasmic mitochondria (CM). High-speed 

centrifugation stripped PDM from lipid droplets (LDs) and pelleted CM mitochondria from 

the supernatant. Note that some BAT mitochondrial isolation protocols discard the fat cake 

and/or begin with high-speed centrifugation step. 
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 Figure 3.2. Separation of fractions by slow-speed centrifugation.  

A. Image of 50mL falcon tube containing BAT homogenate after first slow speed 

centrifugation (Step 3). Note the separation of Fraction 1 and 2. B-C. Supernatant was 

carefully poured into a fresh ice-cold 50mL falcon tube so as to keep fat cake in the original 

falcon tube. The decanted original tube (B) was placed horizontally on ice to harvest fat 

cake. 
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Figure 3.3. Mitochondrial isolation by high-speed centrifugation.  

A. Re-suspended Fraction 1 and Fraction 2 before high-speed centrifugation. B. Top and 

side views of Fraction 1 and Fraction 2 after high-speed centrifugation. Note that Fraction 

2 should have minimal fat layer compared to Fraction 1. Perform additional slow 

centrifugations steps if Fraction 2 has high lipid levels. See text for details.  
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Part Two: Materials and Methods  

Experimental Models and Subjects Details 

Mitochondria were isolated from 12-week-old male C57BL6/J mice and primary 

brown adipocytes were isolated from 3 to 4-week-old wild-type male C57BL6/J 

mice (Jackson lab, Bar Harbor, ME). Animals were fed standard chow (mouse diet 

9F, PMI Nutrition International, Brentwood, MO) and maintained under controlled 

conditions (19–22°C and a 14:10 h light-dark cycle) until euthanasia by isoflurane. 

All animal procedures were performed in accordance with the Guide for Care and 

Use of Laboratory Animals of the NIH, and were approved by the Animal Subjects 

Committee of the University of California, Los Angeles, and the Boston University 

Institutional Guidelines for Animal Care. 

Cell Culture  

Primary brown adipocytes isolation and culture: Brown adipose cells were isolated 

and cultured as described in (Cannon and Nedergaard, 2001b). BAT was 

dissected from interscapular, subscapular, and cervical regions of three male mice, 

minced, and transferred to 10mL collagenase digestion buffer in 50mL Falcon tube 

(2mg/mL Collagenase Type II in 100 mM HEPES, 120 mM NaCl, 4.8 mM KCl, 

1mM CaCl2, 4.5 mM Glucose, 1.5% BSA, pH 7.4). Collagenase digestion was 

performed in 37°C water incubator under constant agitation for 25 minutes with 

vortex agitation every 5 min. Digested tissue was homogenized with 18.5G needle 

and strained through 100 µm and 40 µm filters. 30mL of ice-cold DMEM was added 
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to tissue digest and centrifuged at 200 x g for 10 minutes at 4°C in Sorvall ST 16R 

(Thermo) with TX-200 swinging bucket rotor. Media was carefully removed and the 

cell pellet re-suspended in 30mL ice-cold DMEM media. Cells were centrifuged 

again with the same settings. Next, the cell pellet was re-suspended 5mL growth 

medium (DMEM supplemented with 10% newborn calf serum (NCS), 4 mM 

Glutamine, 10 mM HEPES, 0.1mg/mL sodium ascorbate, 50 U/ml penicillin, 50 

µg/mL streptomycin) and plated in 6-well plate (Corning). Cells were incubated in 

37°C 8% CO2 incubator. 48 Hours are after isolation, the cells were washed to 

remove debris and media was replaced. 72 hours after isolation the cells were 

lifted using STEMPro Accutase, counted, and re-plated in differentiation media 

(growth media supplemented with 1 µM rosiglitazone maleate and 4 nM porcine 

insulin) in final experimental vessel. Cells were differentiated for 7 days and media 

was changed every other day. For transduction experiments, cells were 

transduced with virus in differentiation day 0-3. 

Brown adipocyte immortalization: Brown preadipocytes immortalized by SV40T 

antigen were kindly provided by Drs. Pedro Quiros and Carlos Lopez-Otin (Quirós 

et al., 2012). Immortalized preadipocytes were differentiated for 7 days in culture 

medium supplemented with 20 nM insulin and 1 nM T3, 0.5 mM 

isobutylmethylxanthine, 0.5 µM dexamethasone, and 0.125 mM indomethacin 

(Fasshauer et al., 2000) in 37°C 5% CO2 incubator. 
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INS1 culture: INS-1 832/13 cells were cultured in RPMI 1640 medium 

supplemented with 10% fetal calf serum (FBS), 10 mM HEPES buffer, 1 mM 

pyruvate, 50 µM 2-ß-mercaptoethanol, 50 U/ml penicillin and 50 µg/ml 

streptomycin. Cells were incubated in 37°C 5% CO2 incubator and used between 

passage 60 and 80. 

Peridroplet mitochondrial isolation 

All procedures were performed using pre-chilled equipment and solutions. 

Interscapular BAT from 6 mice was harvested and rinsed in PBS. Tissue was 

weighed, minced, and suspended in 6 mL (~1mL/100mg tissue) Sucrose-HEPES-

EGTA buffer supplemented with BSA (SHE+BSA; 250 mM sucrose, 5 mM HEPES, 

2 mM EGTA, 2% fatty acid-free BSA, pH 7.2). The preparation was then 

mechanically homogenized with 9 strokes in glass-teflon dounce homogenizer. 

The homogenate was then transferred to 50mL falcon tube (Corning) and 

centrifuged in Sorvall ST 16R (Thermo) with TX-200 swinging bucket rotor at 900 

x g for 10 min at 4°C. Supernatant was carefully poured into a new ice-cold falcon 

tube so as to leave the fat layer in the original tube. Keeping the original tube 

horizontal, the fat layer was scraped into a second ice-cold falcon tube and re-

suspended in SHE+BSA buffer. The two fractions were centrifuged again at 900 x 

g for 10 min at 4°C and then transferred into 2mL Eppendorf tubes and centrifuged 

in a microcentrifuge (Thermo) at 9,000 x g for 10 min at 4°C. The pellets were 

resuspended in SHE+BSA and centrifuged with the same settings once more. The 
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pellets were then re-suspended in SHE without BSA and protein concentration was 

determined by BCA (Thermo). BSA was omitted from the final isolation buffer to 

prevent interference with BCA assay. 

 Fluorescence microscopy  

Imaging apparatus: All imaging was performed on Zeiss LSM710 and LSM880. 

Super-resolution imaging was performed with 63x Apochromat oil-immersion lens 

and AiryScan super-resolution detector (Huff, Bathe, Netz, Anhut, & Weisshart, 

2015). Low-resolution images were captured with 10x air objective. Live cell 

imaging was performed with humidified 5% CO2 chamber on a temperature 

controlled stage at 37°C. 

Fluorophore excitation/emission: All fluorophores were excited on separate tracks 

to avoid artifacts due to bleed-through emission. DAPI was excited with 405nm 

30mW laser and its emission captured through 485nm short-pass filter. BODIPY 

493/503, Alexa-Fluor 488, MitoTracker green, and PAGFP were excited with 

488nm 25mW Argon-ion laser and their emission captured through 500-550nm 

band-pass filter. Alexa-Fluor 546, TMRE, and mtDsRed were excited with 543nm 

1mW Helium-Neon laser or 561nm 20mW diode-pumped solid-state laser and 

their emission captured through a 580-650nm band-pass filter. MitoTracker deep 

red was excited using 633nm 5mW Helium-Neon laser and its emission captured 

through a 645nm long-pass filter.  
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Fat layer and isolated mitochondria: 1µL of re-suspended preparation was 

combined with 1µL SHE buffer supplemented with 1µM MitoTracker deep red and 

1µM BODIPY 493/503 on a 1.0mm glass slide (EMS 71867) and covered with #1.5 

thickness coverglass (EMS 72222). Imaging was performed using 63x 

Apochromat oil-immersion lens. 

Live cells: Cells were seeded, transduced, and differentiated in glass-bottom 

confocal plates (MatTek P35G-0.170-14-C). On the day of the experiment, DAPI 

was loaded at 1µg/mL, BODIPY 493/503 was loaded at 200 nM and TMRE was 

loaded at 15 nM for 90 min followed by BODIPY wash-out before imaging. DAPI 

and BODIPY were washed out while TMRE was present during imaging. 

Image analysis: All image analysis was performed in FIJI (ImageJ, NIH). Individual 

mitochondrial fluorescence intensity and area were measured in FIJI and imported 

into Microsoft Excel.  Mitochondria smaller than 10 pixels in area were not included 

in final analyses. Mitochondria within 0.5 µm of lipid droplet edge were defined as 

PDM while mitochondria beyond 0.5 µm peridroplet region were defined as CM. 

Step-by-step instructions:  

1. Manually circle LDs in bright-field image using Oval tool or threshold in BODIPY 

493/503 image using Image>Adjust>Threshold (keyboard shortcut: 

"CNTRL+Shift+T"). Add LD regions to ROI manager (Edit>Selection>Add to 

manager; keyboard shortcut: “T”). ROI manager can be opened from here: 

Analyze>Tools>ROI Manager.  
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2. When selection of LDs is completed, Highlight all LDs in ROI manager by 

clicking “CNTRL+A”. Click "More>>" button and select "OR". This will combine all 

ROIs into a single ROI. Press the key "T" to add newly modified ROI to ROI 

manager. Select this region in ROI manager and Rename it “LD ROI”. Click 

"More>Save" to save ROI. 

3. Enlarge LD mask by 0.5 microns by clicking Edit>Selection>Enlarge and 

entering the value "0.5". Press "T" to add newly modified ROI to ROI manager. 

Select this region in ROI manager and Rename it “Enlarged LD ROI”. Click 

"More>Save" to save ROI. ***CRITICAL: make sure image scale is correct. For 

example, a high resolution image captured with 63x objective is ~ 50x50 

micrometers and 1400x1400 pixels, resulting in 28 pixels per micron. You can 

check image scale in Analyze>Set Scale.  

4. Open TOM20 or matrix-targeted DsRed image and threshold using 

Image>Adjust>Threshold (keyboard shortcut: "CNTRL+Shift+T"). Select the most 

suitable thresholding algorithm to highlight all mitochondria from drop-down menu. 

Once mitochondria are highlighted, select Edit>Selection>Create Selection. 

5. Press "T" to add to ROI manager. Select this region in ROI manager and 

Rename it “Total mitochondria ROI”. Click "More>Save" to save mask. 

6. Highlight Enlarged LD ROI and Total mitochondrial ROI in ROI manager and 

click “More>AND”. This will combine pixels present in both regions into a single 
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region. Select this region and rename it “PDM ROI”. Click "More>Save" to save 

mask. 

 7. Highlight Enlarged LD ROI and Total mitochondrial ROI in ROI manager and 

click “More>XOR”. This will exclude PDM region. Select this region and rename it 

“CM ROI”.  

8. Open COX4 image. Select PDM ROI from ROI manager. Select “More>Split” to 

split ROI into individual mitochondrial regions. Measure by clicking 

"Analyze>Measure" or clicking the "M" key. This will open the Results dialogue 

box. If Results dialogue does not contain desired columns, click the following 

checkboxes in Analyze>Set Measurements: "Area" will display the area of ROI in 

microns; "Integrated density" will display the sum of pixel intensity values in ROI; 

"Mean Gray value" will display the average pixel intensity value in ROI; "Display 

Label" will display ROI next before each row of data.  

9. Select CM mask from ROI manager. Select “More>Split” to split ROI into 

individual mitochondrial regions. Click "M" key to measure.  

10. In Excel, record Mean gray value for CM and PDM. Exclude mitochondria that 

are smaller than 10 pixels in area.  

Image presentation: Image contrast and brightness were not altered in any 

quantitative image analysis protocols. Brightness and contrast were optimized to 

properly display representative images in figure panels. Display settings are 

equivalent in images directly compared to one another. 
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Isolated Mitochondria Proteomics 

100 micrograms of isolated mitochondria were re-suspended in 6M Urea 100 mM 

Tris, pH 8.5 and then reduced and alkylated by incubation in 5 mM TCEP-HCL for 

20 min at room temperature, in the dark (Langousis et al., 2016). Lys-C was 

introduced to the protein suspension at an enzyme to substrate ratio of 1:100, and 

incubated for 4 hours at 37°C. Samples were subsequently diluted to 2M Urea by 

addition of 100 mM Tris, pH 8.5. A final concentration of 1 mM CaCl2 was added 

to the solution, and Trypsin introduced at an enzyme to substrate ratio of 1:50 

overnight at 37°C. Proteolytic digestion was quenched by the addition of formic 

acid to a final concentration of 5%. Prior to mass spectrometric analysis, samples 

were desalted on Pierce C18 StageTips and eluted in 40% ACN before vacuum 

drying and resuspension in 5% formic acid. Desalted samples were separated on 

a 100µM internal diameter, revered phase fused silica column packed with 18cm 

of 1.9 µM C18 particles (Dr. Maisch, GmbH) with an integrated 5µM pulled 

electrospray emitter. Gradient delivery as performed on an Easy nLC-1000 

UHPLC at 300 nl/min, and MS/MS spectra generated by Data Dependent 

Acquisition on a Thermo Q-Exactive mass spectrometer. Data analysis was 

carried out using the Integrated Proteomics pipeline 2 (Integrated Proteomics 

Applications, Inc., San Diego, CA). Specifically, MS/MS spectra were searched 

with the ProLuCID algorithm, and PSM confidence was estimated by DTASelect. 

Search was performed against the Uniprot Mouse proteome containing only 
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reviewed proteins, downloaded on 08/29/2016. Peptide spectrum identifications 

were filtered at a 1% maximum false detection rate as estimated by a target-decoy 

database search strategy. Protein identifications were only considered after 

reaching the requirement of a minimum of two confidently identified peptides. The 

IP2 pipeline provided normalized spectral abundance factor and spectral count 

calculations for set comparisons. 

Isolated Mitochondria Respirometry 

Isolated mitochondria were re-suspended in respiration buffer (100 mM KCl, 10 

mM KH2PO4, 2 mM MgCl2, 5 mM HEPES, 1 mM EGTA, 0.1% BSA, 1 mM GDP, 

pH 7.2) containing substrates (Mahdaviani et al., 2017). Four micrograms per well 

were loaded into Seahorse XF96 microplate in 20µL volume. The loaded plate was 

centrifuged at 2,000 x g for 5 min at 4°C and an additional 115 µL of 

buffer+substrate was added to each well. Substrate concentrations were as follow: 

5 mM Pyruvate + 5 mM Malate, 5mM Succinate + 2 µM Rotenone, 40 µM 

palmitoyl-Carnitine + 1 mM Malate. ADP was injected at port A (3.5 mM final 

concentration), 20 Oligomycin at port B (3.5 µM), FCCP at port C (4 µM) and 

Antimycin A at port D (4 µM). Mix and measure times were 0.5 minutes and 4 

minutes, respectively. A 2 minute wait time was included for oligomycin-resistant 

respiration measurements.  

Cytochrome c oxidase TMPD/Ascorbate respirometry assay 
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Isolated mitochondria were re-suspended in ice-cold respiration buffer and kept 

on ice. Two micrograms of isolated mitochondria were re-suspended in respiration 

buffer and plated on a seahorse XF96 microplate 20 µL volume. Cytochrome c 

oxidase activity was exclusively assessed using 100 µM N,N,N’,N’-Tetramethyl-p-

phenylenediamine (TMPD) and 10 mM Ascorbate, as previously described in 

detail (Divakaruni et al., 2014). To exclude respiration mediated by TCA and other 

electron transport complexes, we injected antimycin/rotenone injection at the start 

of the assay. We confirmed that cytochrome c was not a limiting factor as 

supplementing assay media with exogenous cytochrome c did not alter 

TMPD/ascorbate-mediated respiration. We injected the COX-specific inhibitor 

sodium azide at the end of the assay to confirm that TMPD/ascorbate-driven 

respiration was specific to COX activity.  

ATP Synthesis Assay 

One microgram of isolated mitochondria were re-suspended in mitochondrial 

respiration buffer containing 5 mM pyruvate + 5 mM malate + 3.5 mM ADP and 

kept on ice (Wibom, Lundin, & Hultman, 1990). 50 µL of this mixture was combined 

with 50 µL of Luciferin-luciferase mix in clear-bottom black 96-well plate (Corning) 

and measured immediately. We determined the optimal concentration of reagents 

and measurement settings on our instrument using HPLC-purified ATP standards. 

Luminescent counts were integrated over 0.5 seconds at 10 second intervals 

separated by 0.5 second orbital shaking on Spark M10 microplate reader (Tecan). 
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To control for non-OXPHOS ATP synthesis, we assessed luminescence in parallel 

samples that were treated with the ATP synthase inhibitor oligomycin A. We 

confirmed ATP contamination of ADP preparation was minimal by assaying ADP 

by itself. The linear rate of luminescence increase was calculated to determine 

ATP synthesis rate.  

Protein Gel Electrophoresis and Immunoblotting 

SDS-PAGE: 10-20 µg of isolated mitochondrial protein was re-suspended in 

NuPAGE LDS Sample Buffer with protease inhibitor cocktail and incubated at 45C 

for 10 min. Samples were then loaded into 4-12% Bis-Tris precast gels 

(ThermoFisher Sci. NP0321) and electrophoresed in xCell SureLock (Novex) in 

constant voltage at 60V for 15 minutes (to clear stacking) and 150V for 45 minutes.  

Blue native gel electrophoresis: 10-50 µg of isolated mitochondrial protein was re-

suspended in 20 µL solubilization buffer (50mM Imidazole, 500mM 6-

aminohexanoic acid, EDTA 1mM pH 7.0)(Wittig, Braun, & Schägger, 2006). 8 mg 

digitonin/mg of mitochondrial protein was added and samples were incubated on 

ice for 5 minutes. Since commercial digitonin is only 50% pure, we used 16 mg of 

crude powder to achieve 8mg (no re-crystallization). Digitonin was dissolved in 

PBS by boiling and stored at 4°C until use. Solubilized samples were centrifuged 

at maximal speed in a microcentrifuge (Thermo) for 30 min at 4°C. Pellet was 

discarded and supernatant was combined with 1 µL of 2.5% Coomassie G-250. 

Samples were loaded into NativePAGE 3-12% Bis-Tris gel and electrophoresed 
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at 4°C in xCell SureLock (Novex) in constant voltage at 20V for 60 minutes and 

200V for 120 minutes or until dye front exited the gel.  

Immunoblotting: Proteins were transferred to methanol-activated PVDF 

membrane in xCell SureLock in 30V constant voltage for 1 hour at 4°C. 

Commassie was completely washed off blue native blots using 100% methanol. 

Blots were blocked with 5g/100mL non-fat dry milk in 0.5ml/L PBST (1mL/L 

Tween-20/PBS) and incubated with primary antibody diluted in 1g/100mL 

BSA/PBST overnight at 4°C. The next day, blots were washed 3x10min in PBST, 

probed with HRP-linked secondary antibodies diluted in blocking solution for 1 

hour at room temperature, and rinsed again 3x10min in PBST. Detection was 

achieved by ECL-Plus reagent and imaging was performed with Typhoon 9410 

Molecular Imager (Amersham). Image contrast was uniformly reduced to enhance 

visibility. Band densitometry was quantified using ImageJ Gel Plugin (NIH).  

Immunofluorescence 

Cells were cultured, transduced, and differentiated on coverslips and fixed at 4% 

vol/vol PFA for 15 min at room temperature. After washing in PBS, cells were 

incubated in permeabilization buffer (2 µl/mL Triton X-100, 0.5 mg/mL Sodium 

Deoxycholate in PBS, pH 7.4) for 15 min at room temperature. Cells were then 

blocked with 3g/100mL BSA for 1 hour at room temperature. Next, cells were 

incubated with 1:200 primary antibody at 4°C overnight. The next day, cells were 

washed in PBS and incubated with 1:500 Anti-Mouse Alexa Fluor 488 or Anti-
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Mouse Alexa Fluor 546 secondary antibodies for 1 hour at room temperature. After 

washing in PBS, coverslips were mounted in MOWIOL on glass slide, air-dried, 

and stored at 4°C. 

Citrate Synthase Assay 

Citrate synthase activity was performed using 5,5′-Dithiobis(2-nitrobenzoic acid) 

(DTNB) (Spinazzi, Casarin, Pertegato, Salviati, & Angelini, 2012). Isolated 

mitochondria were re-suspended in 200mM Tris buffer containing 0.2% v/v Triton 

X-100 (pH 8.0), 100 µM DTNB, and 300 µM acetyl-CoA and loaded into a clear-

bottom black 96-well plate.  Baseline 412nm absorbance was measured using 

Spark M10 microplate reader (Tecan). Oxaloacetate was then added and 412nm 

absorbance was repeatedly measured at 20 second intervals. The linear rate of 

absorbance increase was calculated to determine citrate synthesis rate.  

NAD(P)H Imaging 

NAD(P)H autofluorescence was excited using 730nm 2-photon Chameleon Vision 

laser (Coherent) to give 365 nm photo-equivalence at the focal plane. 425-475nm 

emission was detected by ultra-high sensitivity Gallium Arsenide Phosphide 

detectors with non-descanned beampath to maximize emission collection and 

minimize laser power. To minimize artifacts due to phototoxicity and bleaching, 

image acquisition settings were optimized on a test cell that was not included in 

final image analysis. Images of analyzed cells were subsequently acquired using 

a single laser scan.  
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Electron Microscopy 

Interscapular brown adipose tissue was harvested from mice acclimated to 28°C 

for 2-4 weeks and from mice acclimated to 6°C for 1-5 days. Small tissue 

fragments were fixed in 2% glutaraldehyde/2% paraformaldehyde in 0.1M 

phosphate buffer, pH 7.4, for 4 hours at room temperature (Cinti et al., 2002). 

Samples were post-fixed in 1% osmium tetroxide, dehydrated in ethanol, and 

embedded in epoxy resin. Thin sections were obtained by MTX ultramicrotome 

(RMC, Tucson, AZ), stained with lead citrate, and imaged with Philips CM10 

transmission electron microscope (Philips, Eindhoven, Netherlands). Imaging of 

cross-ruled grating of known distance was used to calibrate images.  

Image analysis: Mitochondria were manually traced in electron micrographs and 

quantified in ImageJ. Aspect ratio was calculated as the major axis divided by the 

minor axis.   

Virus Preparation 

Plin5 and Plin5∆399-463 constructs were a generous gift from Carole Sztalyrd (H. 

Wang et al., 2011). Plasmids were modified to express mKATE2 far-red 

fluorophore to enhance compatibility with fluorescent dyes and packaged into 

adenoviral particles (Welgen, Inc.). Viral transduction was confirmed by mKATE2 

fluorescence. Lentiviral particles for mtPAGFP, mtDsRed, and DRP1DN were 

generated as previously described in detail (Wikstrom et al., 2014).  
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Gene delivery: Pre-adipocytes and INS1 cells were incubated with 0.3 µL/mL of 

adenoviral preparation for 5 hours in complete culture media. This was sufficient 

to achieve transduction in the majority of cells with little to no toxicity as assessed 

by cell division and viability. Fluorescent label and protein expression were 

detectable at differentiation day 7. Lentiviruses were delivered as previously 

described in detail (Wikstrom et al., 2014). 

Lipolysis Assay 

Cells were seeded, transduced and differentiated in 96-well plate. On the day of 

experiment, the cells were washed once and incubated with 100 µL Krebs-Ringer 

Bicarbonate Buffer (KRB; 119mM NaCl, 4.6mM KCl, 5mM NaHCO3, 2mM CaCl2, 

1mM MgSO4, 0.15mM Na2HOP4, 0.4mM KH2PO4, 20mM HEPES, 5mM 

Glucose, pH 7.4) for 2 hours. KRB was collected and assayed for glycerol using 

Free Glycerol Colorimetric/Fluorometric Assay Kit (BioVision) according to the 

manufacturer instructions.  

Thin Layer Chromatography 

Cells were seeded, transduced, and differentiated in 6-well plate. Cells were 

washed and incubated with overnight with 1 µM BODIPY C12 558/568 as 

previously described (Rambold et al., 2015). Cells were harvested using Accutase 

and spun down. Cellular lipids were extracted in chloroform and developed on 

aluminum-backed silica plates (Sigma 55811) using 1:2 cyclohexane:ethyl 
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acetate. Plates were imaged using Typhoon 9410 Molecular Imager (Amersham) 

and spots were quantified using ImageJ Gel Plugin. 

Mitochondrial Fusion Assay  

Brown adipocytes were seeded, transduced, and differentiated in glass-bottom 

confocal plates (MatTek). mtPAGFP was activated using 750nm 2-photon 

Chameleon Vision laser (Coherent) to give 375nm photo-equivalence at the focal 

plane (Twig et al., 2008, 2010). The diffusion of mtPAGFP was assessed by 

repeatedly scanning the cell at 15 minute intervals. GFP fluorescence was 

quantified within the region of interest at every time point to assess diffusion. 

Diffusion of cytosolic mitochondria PAGFP reached as steady state within 40-50 

minutes after photo-activation. At this time point, mitochondria that retained non-

diluted GFP were defined as non-fusing mitochondria. 

QUANTIFICATION AND STATISTICAL ANALYSIS  

All data analyses were performed using GraphPad Prism 5 and Microsoft Excel. 

Raw data from each individual experiment was evaluated using an unpaired two-

tailed t-test with 95% confidence in Prism. For data sets that did not pass the 

D'Agostino and Pearson omnibus normality test (alpha = 0.05), differences were 

evaluated using a two-tailed unpaired non-parametric Mann-Whitney test with 95% 

confidence. For repeated independent experiments, the raw data of CM and PDM 

from each individual experiment were normalized to the average value of all 

mitochondria in that specific experiment as shown in the formula below. 
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Experiment-normalized data was then evaluated by a paired two-tailed t-test with 

95% confidence.  

( ) replicates PDM andCM  ofnumber  totalPDMCM

replicatesCM  ofnumber CM
CM

raw valuesraw values

raw values

normalized ∑ ∑
∑

+
=  

( ) replicates PDM andCM  ofnumber  totalPDMCM

replicates PDM ofnumber PDM
PDM

raw valuesraw values

raw values

normalized ∑ ∑
∑

+
=  

 

Key resource table  
REAGENT or RESOURCE SOURCE IDENTIFIER 

Antibodies 

Mouse anti-Complex I NDUFB8 ThermoFisher Sci. Clone 20E9DH10C12, Cat. 
#459210 

Mouse anti-Complex II SDHB Abcam Clone EPR10880, Cat. 
#175225 

Mouse anti-Complex III UQCRC1 ThermoFisher Sci. Cone 16D10AD9AH5, Cat. 
#459140 

Mouse anti-Complex 4 COX4 ThermoFisher Sci. Clone 1D6E1A8, Cat. #459600 

Mouse anti-ATP Synthase ATP5A1 ThermoFisher Sci. Clone 15H4C4, Cat. #43-9800 

Rabbit anti-TOM20 Santa Cruz Biotech. Cat. #11415 

Rabbit anti-UCP1  Abcam Cat. #10983 

Mouse anti-DLP1 (DRP1) BD Biosciences Clone 8/DLP1, Cat. #611113 

Mouse anti-OPA1  BD Biosciences Clone 18/OPA1, Cat. #612607 

Anti-mouse HRP-linked Cell Signaling Tech. Cat. #7076S 

Anti-rabbit HRP-linked Cell Signaling Tech. Cat. #7074S 

Goat anti-Mouse IgG (H+L) 
Secondary Antibody, Alexa Fluor 
488 conjugate 

ThermoFisher Sci. Cat. #A11001 

Donkey anti-Rabbit IgG (H+L) 
Secondary Antibody, Alexa Fluor 
546 conjugate 

ThermoFisher Sci. Cat. #A10040 

Bacterial and Virus Strains  

Full-length Plin5 Adenovirus that 
includes mitochondrial recruiting 
sequence 

Welgen, Inc. Ad-CMV- Plin5(aa1-463)-
mKate2 

Truncated Plin5∆399-463 
Adenovirus lacking mitochondrial 
recruiting sequence 

Welgen, Inc. Ad-CMV- Plin5(aa1-399)-
mKate2 

mt-PAGFP Lentivirus (Twig et al., 2008) pLV-CATG Trono Lab/Addgene 

mt-DsRed Lentivirus (Twig et al., 2008) pLV-CATG Trono Lab/Addgene 
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Biological Samples   

Interscapular brown adipose tissue 
from healthy 12-week-old male 
C57BL/6J 

Jackson lab Cat. #000664 

Chemicals, Peptides, and Recombinant Proteins 

Fatty Acid-Free Bovine Serum 
Albumin 

EMD Millipore  Cat. #126575 

BODIPY 493/503 (4,4-Difluoro-
1,3,5,7,8-Pentamethyl-4-Bora-
3a,4a-Diaza-s-Indacene) 

ThermoFisher Sci. Cat. #D3922 

MitoTracker Deep Red FM ThermoFisher Sci. Cat. #M22426 

MitoTracker Green FM ThermoFisher Sci. Cat. #M7514 

Tetramethylrhodamine, Ethyl Ester, 
Perchlorate (TMRE) 

ThermoFisher Sci. Cat. #T669 

Ultrapure dimethyl sulfoxide 
(DMSO) 

Amresco Cat. #N182 

Sodium Pyruvate ThermoFisher Sci. Cat. #BP356 

L-(-)-Malic Acid  Sigma-Aldrich Cat. #M6413 

Succinic Acid Sigma-Aldrich Cat. #S9512 

Rotenone Sigma-Aldrich Cat. #R8875 

Palmitoyl-L-carnitine chloride Sigma-Aldrich Cat. #P1645 

Adenosine 5'-diphosphate 
monopotassium ADP) 

Sigma-Aldrich Cat. #A5285 

Oligomycin A Sigma-Aldrich Cat. #75351 

FCCP Sigma-Aldrich Cat. #C2920 

Antimycin A Sigma-Aldrich Cat. #A8674 

N N N' N'-tetramethyl-p-
phenylenediamine (TMPD) 

Sigma-Aldrich Cat. #T7394 

(+)-Sodium L-Ascorbate Sigma-Aldrich Cat. #A4034 

Sodium Azide Sigma-Aldrich Cat. #S8032 

Guanosine 5’-diphosphate sodium 
type I (GDP) 

Sigma-Aldrich Cat. #G7127 

NuPAGE MES SDS Running Buffer 
(20X) 

ThermoFisher Sci. Cat. #NP000202 

NuPAGE Transfer Buffer (20X) ThermoFisher Sci. Cat. #NP0006-1 

NuPAGE LDS Sample Buffer ThermoFisher Sci. Cat. #NP0007 

Coomassie Brilliant Blue G-250 Amresco Cat. #0615 

Digitonin Sigma-Aldrich  Cat. #D5628 

Native PAGE 20X Running buffer ThermoFisher Sci. Cat. #BN2001 

NuPAGE 4-12% Bis-Tris Protein 
Gels, 1.0 mm, 10-well 

ThermoFisher Sci. Cat. #NP0321 

NativePAGE 3-12% Bis-Tris Protein 
Gels, 1.0 mm, 15-well 

ThermoFisher Sci. Cat. #BN1003 

Protease inhibitor cocktail Santa Cruz Cat. #24948A  

5,5’-Dithiobis(2-nitrobenzoic acid) 
(DTNB)  

Sigma-Aldrich Cat. #D218200 
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Acetyl coenzyme A lithium salt Sigma-Aldrich Cat. #A2181 

Oxaloacetic acid Sigma-Aldrich Cat. #O4126 

Insulin from porcine pancreas  Sigma-Aldrich Cat. #I5523 

Rosiglitazone Maleate  Sigma-Aldrich Cat. #1605817 

BODIPY 558/568 C12 (4,4-Difluoro-
5-(2-Thienyl)-4-Bora-3a,4a-Diaza-s-
Indacene-3-Dodecanoic Acid) 

ThermoFisher Sci. Cat. #D3835 

Fatty Acid-Free Bovine Serum 
Albumin 

EMD Millipore  Cat. #126575 

Collagenase Type II Worthington Cat. #E11231 

BODIPY 493/503 (4,4-Difluoro-
1,3,5,7,8-Pentamethyl-4-Bora-
3a,4a-Diaza-s-Indacene) 

ThermoFisher Sci. Cat. #D3922 

MitoTracker Deep Red FM ThermoFisher Sci. Cat. #M22426 

MitoTracker Green FM ThermoFisher Sci. Cat. #M7514 

Tetramethylrhodamine, Ethyl Ester, 
Perchlorate (TMRE) 

ThermoFisher Sci. Cat. #T669 

Ultrapure dimethyl sulfoxide 
(DMSO) 

Amresco Cat. #N182 

Sodium Pyruvate ThermoFisher Sci. Cat. #BP356 

DMEM ThermoFisher Sci. Cat. #31800022 

RPMI 1640 ThermoFisher Sci. Cat. #12100046 

Penicillin-Streptomycin ThermoFisher Sci. Cat. #15140 

Fetal calf serum ThermoFisher Sci. Cat. #16000 

Newborn calf serum Sigma-Aldrich Cat. #N4637 

STEMPro Accutase ThermoFisher Sci. Cat. #A1110501 

Critical Commercial Assays 

Pierce BCA ThermoFisher Sci. Cat. #23225 

ECL Plus Western Blotting 
Substrate 

ThermoFisher Sci. Cat. #32132 

Free Glycerol Assay Kit BioVision Cat. #K630-100 

ATP Bioluminescence Assay Kit 
CLS II  

Roche Cat. #11699695001 

Experimental Models: Cell Lines 

Pre-adipocytes (Quirós et al., 2012) N/A 

INS1 832/13 (Twig et al., 2008) N/A 

Software and Algorithms 

ImageJ NIH https://fiji.sc/ 

Graphpad GraphPad Software https://www.graphpad.com 

Integrated Proteomics pipeline 2 Integrated 
Proteomics 
Applications, Inc. 

http://www.integratedproteomic
s.com/ 
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CHAPTER FOUR: Function and Physiology of Mitochondria Bound to Lipid 

Droplets 

Abstract 

Mitochondria have been shown to associate with lipid droplets (LDs) in a variety of 

tissues and cell types but the functional role of these peridroplet mitochondria (PDM) 

remains is unknown. In this review we summarize the current evidence for the functional 

role of PDM in LD expansion and oxidation, the role of PDM in obesity pathophysiology, 

and the potential molecular mechanisms by which mitochondria are recruited to LDs. 

Much exciting experimental work remains to be done to unveil the physiological roles of 

PDM. 

 

Introduction 

Cells require a continuous input of nutrients to maintain energy homeostasis. 

However, excess nutrients are harmful as fatty acids and glucose irreversibly modify 

proteins and disrupt cellular function. Cytoplasmic fatty acids imported from circulation or 

synthesized de novo are processed towards oxidative phosphorylation in the mitochondria 

or stored as triacylglycerides (TAGs) in lipid droplets (LDs) for later use. Free fatty acids 

destined for either oxidation or storage must first undergo ATP-dependent ligation to 

coenzyme A. Fatty acyl-CoAs destined for storage are sequentially esterified to glycerol 

backbone by glycerol-acyltransferases. On the other hand, fatty acyl-CoAs destined for 

oxidation are converted to acyl-carnitine on the outer mitochondrial membrane for 

mitochondrial import and oxidation. Mitochondria have been shown to physically contact 

lipid droplets in multiple tissues. It remains unclear whether PDM promote TAG synthesis, 
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fatty acid oxidation, or both. Here we review the current evidence on the structure and 

function of peridroplet mitochondria (PDM).  

What is the evidence for a role of PDM in LD expansion versus consumption? 

Peridroplet mitochondria have been observed in a variety of cell culture models 

and tissue types. However, it remains unclear whether PDM promote lipid storage, 

oxidation, or both (Figure 4.1). To better understand the role of PDM, we have summarized 

the effect of different physiological conditions on the abundance of PDM, LD accumulation, 

and mitochondrial FAO (Table 4.1). If PDM play a role in LD accumulation, we expect that 

a higher proportion of mitochondria will be associated to LDs under physiological 

conditions of increased LD synthesis. On the other hand, if PDM is part of a cellular 

adaptation for fat oxidation, we expect PDM to increase in abundance under physiological 

conditions in which fatty acid oxidation rate is maximized.  

What can be learned about PDM from brown adipose tissue? 

Several groups have attempted to elucidate the role of PDM using brown adipose 

tissue (BAT), a system that robustly shifts from lipid storage to oxidation upon cold 

exposure (Cannon and Nedergaard 2004). Proteomic analysis by Yu et al. showed that 

85 of the 130 measured mitochondrial proteins (65%) were undetectable or decreased in 

lipid droplets isolated from BAT of cold-exposed mice compared to mice housed in 

thermos-neutral conditions (Yu et al., 2015). This suggest that mitochondrial association 

to LDs is reduced under cold-exposure, when fatty acid oxidation is maximized for 

thermogenesis, compared to thermoneutral conditions, where fatty acids are primarily 

directed toward LD synthesis. Electron microscopy analysis of BAT isolated from 

thermoneutral and cold-adapted mice confirmed that mitochondrial depart from LDs upon 
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cold exposure (Benador et al., 2018). In addition, PDM isolated from BAT have been 

shown to have lower fatty acid oxidation capacity compared to cytoplasmic mitochondria 

(CM). These results support a role for PDM in BAT LD synthesis rather than oxidation.  

Do PDM play a role in LD expansion? 

Studies in cell culture models of LD expansion by oleate loading have observed a 

striking re-arrangement of mitochondria around LDs. Elegant work by Wang et al have 

shown that over expressing the lipid coat protein Perilipin5 (Plin5) uniquely recruits 

mitochondria to LDs (Wang et al. 2011) in addition to its regulation of adipose 

triacylglyceride lipase (ATGL). Over expression of Plin5, but not Plin1-4, resulted in 

complete mitochondrial recruitment to LDs and increased LD mass in CHO, AML12, HL-

1 cells. This was later confirmed in vivo using transgenic Plin5 mice (H. Wang et al., 2013). 

However, since Plin5 over expression was only compared to GFP controls, it is not 

possible to discern from these studies if the changes in LD mass were a result of ATGL 

modulation or from mitochondrial recruitment to the LD surfaces. Later studies specifically 

determined the functional role of mitochondrial recruitment by comparing over expression 

of the full transcript of Plin5 to truncated Plin5 in which the C-terminal mitochondrial 

targeting sequence was specifically deleted (Benador et al. 2018). Experiments performed 

in both adipose and non-adipose cells confirmed that mitochondrial recruitment to the LDs 

doubled LD cross-sectional area and enhanced TAG synthesis independent of lipolysis 

regulation. 

Remarkably, the TAG synthesizing enzyme diacylglycerol acyltransferase 2 

(DGAT2) was also shown to recruit mitochondria to LDs in COS-7 cells. Stone et al. 

demonstrated that DGAT2 contains a unique mitochondrial targeting sequence that 
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recruits mitochondria to LDs upon stimulation of LD synthesis (Stone et al., 2009)(Figure 

3). Over expression of DGAT2 resulted in complete mitochondrial recruitment to newly 

formed LDs and a doubling in size of LDs while over expression of DGAT1 or MGAT2, 

which do not contain a mitochondrial targeting sequence, did not recruit mitochondria to 

LDs nor increase LD size. These results thus support a role for mitochondrial recruitment 

in LD expansion in mammalian cell culture models of LD biogenesis induced by lipid 

loading.  

PDM have also been observed in models of LD formation due to energy stress by 

multiple groups. Mouse embryonic fibroblasts deprived of nutrients showed a dramatic re-

organization of mitochondria around lipid droplets and increased LD biogenesis. However, 

while Rambold et al. suggested these PDM direct the excess fatty acids liberated by 

autophagy toward mitochondrial beta oxidation, Nguyen et al. concluded that PDM direct 

fatty acid trafficking toward LD storage to protect mitochondria from lipotoxicity (Nguyen 

et al., 2017; Rambold et al., 2015). Thus, while LD expansion and mitochondrial 

recruitment are consistently observed in cell culture models of nutrient deprivation, it 

remains unclear whether PDM also play a role in fatty acid oxidation.  

Do PDM expand all LDs equally?  

The studies described above support a role of PDM in LD expansion. Importantly, 

the effects of mitochondrial recruitment on LD expansion in all studies centered on micro 

LDs (mLD, <2um), suggesting that mitochondrial recruitment may play a role in expansion 

of nascent LDs rather than expanding larger LDs. Indeed, mLDs appear to have the 

highest rates of TAG synthesis and expansion in cultured white adipocytes (Jude Deeney, 

personal communication). Furthermore, Zhang et al. demonstrated that mLDs have a 
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distinct lipid composition, protein composition, and organelle association in Huh7 cells, 

CHO K2 cells, mouse BAT, and mouse liver (Zhang et al., 2016). Indeed, studies have 

demonstrated that PDM enhance mLD expansion by providing ATP to power TAG 

synthesis, suggesting that PDM provide energy for ATP-dependent acyl-CoA synthesis 

(Benador et al. 2018). Consistent with this interpretation, Zhang et al. demonstrate that 

isolated mLD are capable of synthesizing TAGs in a cell-free environment when provided 

with ATP and CoA (Zhang et al., 2016). The exceptionally high Km  value for ATP of Acyl 

CoA Synthetase (4.65mM) (Bar-Tana & Shapiro, 1975), suggest that ATP availability may 

be an important regulatory mechanism for TAG synthesis. Taken together, the studies 

reviewed above support the conclusion that PDM support mLD expansion by providing 

ATP for acyl-CoA synthesis in the TAG synthesis pathway. It remains an open question 

whether PDM further enhance TAG synthesis by additionally providing citrate for de novo 

lipogenesis.  

What is the biochemical nature of mitochondria-LD association and how is 

it regulated?  

The molecular composition and regulation of the bridge connecting mitochondria 

to LDs is currently unknown. However, several published reports have suggested potential 

models of the interaction (Table 2). Experiments with isolated organelles demonstrated 

that isolated mitochondria can interact with isolated LDs in a cell free environment 

(Jagerstrom et al.). This interaction was further enhanced by adding the cytoplasmic 

fraction, suggesting that factors both on the outer organellar membranes as well as in the 

cytoplasm promote mitochondria-LD interaction.  
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As mentioned above, work published by our and other labs have shown that the lipid 

droplet coat protein Perilipin 5 (Plin5), but not Plin1-4, strongly recruits mitochondria to the 

LDs in CHO, AML12, HL-1 cells, primary brown adipocytes, and INS1 cells, and mouse 

heart. Site-directed mutagenesis unveiled a highly conserved sequence of the C-terminus 

that recruits mitochondria to LDs. Additional experiments show that fusing Plin2, which 

induces LD formation but does not recruit mitochondria on its own, to the C-terminus of 

Plin5 is sufficient to induce mitochondrial recruitment. However, despite considerable 

efforts to elucidate the protein or membrane partner of Plin5, the molecular mechanism 

by which Plin5 recruits mitochondria remains unclear (Carole Sztalyrd, personal 

communication). Interestingly, a recent report by Gallardo-Montejano et al. demonstrated 

that phosphorylated Plin5 translocated to the nucleus, where it partners with PGC1alpha 

to regulate gene transcription (Gallardo-Montejano et al., 2016). This suggests that Plin5 

may regulate mitochondrial recruitment to LDs indirectly through signaling pathways rather 

than direct biochemical interaction.  

Additional protein candidates have been suggested. Stone et al. showed that 

diacylglycerol acyltransferase 2 (DGAT2), which is known to localize to ER and LDs 

membranes, also possess an N-terminal mitochondrial targeting sequence using site-

directed mutagenesis. Additional experiments demonstrated that fusing the N-terminus to 

RFP was sufficient to target it to mitochondria. These data suggest that DGAT2 directly 

interacts with both LD and mitochondrial membranes. 

Protein-protein interaction as a mechanism of mitochondria-LD association has previously 

been suggested (Boutant et al., 2017). However, elegant biochemical experiments in 

isolated BAT LDs demonstrated that mitochondrial association to LDs is resistant to tryptic 
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digestion and high salt wash that disrupt protein-protein interactions (Yu et al., 2015). The 

sensitivity of mitochondria-LD association to detergent wash suggested that, while protein-

protein interaction may be involved in initiation of mitochondrial requirement, 

mitochondria-LD association it is ultimately stabilized by additional membrane-protein 

and/or membrane-membrane interactions, such as hemifusion. This interpretation is 

supported by the increased thickness and enhanced electron density of membranes 

observed in the interface of mitochondria-LD association by electron microscopy studies 

(Benador et al., 2018). 

What is the role of PDM in obesity? 

 Obesity is characterized by hypertrophic and hyperplastic adipose tissue 

hypertrophy and intracellular lipid accumulation in liver and muscle. Whether PDM play a 

role in lipid accumulation in obesity remains an open question. We summarize the current 

evidence for the involvement of PDM in obesity-related lipid droplet accumulation below.  

Do PDM play a role in adipose tissue expansion? 

Hyperplastic and hypertrophic WAT hypertrophy are the hallmarks of obesity. 

Studies have consistently shown that white adipocytes in early stages of differentiation, 

when LD synthesis is highest, have high levels of mitochondrial mass compared to 

adipocytes late stages of differentiation, where LD synthesis is relatively low. While there 

is currently no direct evidence for the existence of PDM in WAT, the association between 

mitochondrial mass and LD synthesis rate suggests a potential role for PDM in LD building 

in the early stages of adipocyte differentiation. Indeed, our unpublished microscopic 

observations confirmed that cultured white adipocytes have high levels of PDM in early 

stages of differentiation, where LD synthesis is maximal. In conclusion, there is currently 
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no direct published evidence for the existence of PDM in WAT but our unpublished 

observations suggest that PDM may play in hyperplastic adipose tissue growth. This will 

need to be confirmed by future studies.  

Do PDM play a role in intramyocellular lipid accumulation? 

Muscle tissue synthesizes lipid droplets under multiple metabolic conditions, 

including fasting, endurance training, and over feeding. In heart, Wang et al. have 

demonstrated that fasted mice have increased levels of PDM in addition to increased LD 

accumulation (H. Wang et al., 2013). Transgenic mice over expressing Plin5 had 

enhanced cardiac LD accumulation under both fed and fasted conditions as well as a 

reduction in lipid utilization. On the other hand, whole body Plin5KO mice had severe 

cardiac LD depletion, increased fatty acid oxidation, and ROS-mediated cardiac 

dysfunction (Kuramoto et al., 2012). However, the recovery of LDs in animals treated with 

lipase inhibitors suggests that lipolysis dysregulation in Plin5KO animals played a 

significant role in this phenotype. Taken together, these studies suggest that PDM could 

play a role in cardiac LD accumulation but further studies are needed to precisely define 

their physiology.  

In skeletal muscle, LDs have been shown to accumulate both obese and trained 

athletes with opposite effects on insulin sensitivity (athlete’s paradox). Electron 

microscopy evidence has demonstrated that endurance exercise increased levels of PDM 

and LD accumulation in human skeletal muscle (Tarnopolsky et al., 2007). Remarkably, 

the subcellular location of LDs in trained individuals was interfibrillar compared to 

subsarcolemmal in obese individuals (Nielsen et al. 2017). Since PDM appear to localize 

to interfibrillar region of muscle fibers, we may infer from these studies that PDM play a 
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role in adaptive rather than pathological LD accumulation. Indirect evidence in support of 

this suggestion is that muscle-specific Plin5 over expression increased PDM (Bosma et 

al., 2012) and protected muscle tissue from high fat diet-induced lipotoxicity (Laurens et 

al., 2016). However, as mentioned before, it remains unclear whether Plin5 effects are 

mediated by lipolysis regulatory function, mitochondrial recruitment, or both. In summary, 

additional studies are needed to determine the precise role of PDM in physiological and 

pathological LD accumulation in muscle tissue.   

What is the evidence that PDM exist in liver?  

The liver is specialized to synthesize lipids post-prandially for distribution to other 

tissues. In pathological conditions, the liver accumulates excess lipid droplets, which 

eventually progress to a chronic inflammatory state and cirrhosis. Although PDM have not 

been specifically studied and quantified in liver, various evidence suggest that PDM may 

exist and play a role in hepatocytes. For example, published electron microscopy images 

of livers from HFD and genetic models of obesity appear to have increases levels of PDM 

(Arruda et al., 2014)(Figure 1, Supplemental Figure 1). Furthermore, high-fat feeding has 

been shown to increase Plin5 expression in both human and mouse liver tissue (C. Wang 

et al., 2015) and the over expression of Plin5 (Trevino et al., 2015) and DGAT2 (Monetti 

et al., 2007) increased LD mass and protected against lipotoxic liver injury. In summary, 

there is currently no direct evidence for the existence or physiological relevance of PDM 

in liver tissue and additional studies are warranted. 

What is the physiological role of LDs synthesized by PDM? 

Determining the role of PDM requires gain-of-function and loss-of-function models 

that are currently lacking. An experimental system where mitochondrial association to LDs 
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can be acutely disrupted would be ideal to determine its physiological significance.  While 

this system has yet to be developed, several genetic models have been reported in which 

mitochondria-LD association was found to be reduced.  

Our lab has recently published on a mouse model that serendipitously had a 

reduction in PDM (Mahdaviani et al., 2017). Mice with BAT-specific knock out of the 

mitochondrial fusion protein Mfn2 had severely diminished mitochondrial association with 

LDs. Interestingly, Mfn2KO BAT had enhanced mitochondrial fatty acid oxidation capacity 

concomitant with increased LD synthesis. One interpretation of these results is that 

Mfn2KO BAT has enhanced capacity to oxidize fatty acids coming from circulation but 

reduced capacity to oxidize fatty acids from LDs. This phenotype is reminiscent of 

muscular tissue from obese individuals, where Mfn2 is downregulated and dysfunctional 

LD content is increased. These findings suggest that the macro LDs accumulated in the 

absence of Mfn2 and PDM represent a functionally different class than mLDs synthesized 

in the presence of PDM. This interpretation is consistent with reports functional 

heterogeneity of LDs from different size classes (Zhang et al., 2016). The severe BAT 

dysfunction and cold-intolerance exhibited by Mfn2KO mice leads us to speculate that 

mLDs synthesized in the presence of PDM may represent a compartmentalized pool of 

TAGs destined for oxidation as opposed to the macro LDs that are inaccessible during 

cold exposure. This view is consistent with the work from Rosalind Coleman’s group that 

demonstrated the existence of compartmentalized metabolic pools of fatty acid 

metabolites (Cooper, Young, Klett, & Coleman, 2015; Ellis et al., 2010; L. O. Li et al., 

2015). Future work will be needed to confirm if and how PDM synthesize a 

compartmentalized lipid pool. 
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Conclusions 

This is an exciting time for PDM research. Work reported in the last decade has opened 

a new territory of cell biology that may have important implications for fat metabolism. 

However, animal models that specifically disrupt mitochondria-LD interaction are still 

needed to better understand the physiological impact of this phenomenon. A better 

understanding PDM and LD biology is of great importance as the twin pandemics of 

obesity and type 2 diabetes mellitus continue to soar and decrease lifespan and 

healthspan. We hope that this research avenue will bear new insights into cell metabolism 

and ultimately translate to more effective therapies for obesity and type 2 diabetes.  
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Figures 

Figure 4.1. Illustrations of the potential roles of peridroplet mitochondria.  
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Tables 

 
Table 4.1. Conditions that increase mitochondrial recruitment to LDs 

 Cell type Condition Mito-LD 
interaction 

LD 
Mass 

FAO 

Brown adipose tissue      

(Benador et al., 2018) Mouse BAT Thermoneutrality 
compared to cold 
exposure 

Higher Higher Lower 

(Yu et al., 2015) Mouse BAT Thermoneutrality 
compared to cold 
exposure 

Higher 
(Table S6) 

Higher Lower 

Cell culture      
(H. Wang et al., 
2011) 

CHO, 
AML12, HL-
1 cells 

Oleate loading in 
Plin5 over 
expression vs GFP 
control 

Higher Higher Lower 

(Benador et al., 2018) Primary 
brown 
adipocytes 

Plin5 vs C-truncated 
Plin5 

Higher Higher N/A 

(Stone et al., 2009) COS-7 Oleate loading 
DGAT2 over 
expression vs 
DGAT1 and MGAT2 

Higher Higher N/A 

(Rambold et al., 
2015) 

MEF Nutrient deprivation 
compared to 
complete medium 

Higher Higher Higher 

(Nguyen et al., 2017, 
p. 1) 

MEF Nutrient deprivation 
compared to 
complete medium 

Higher Higher Higher 

Striated muscle      
(Tarnopolsky et al., 
2007) 

Human 
Vastus 
Lateralis 
muscle  

Post-endurance 
training vs pre-
training 

Higher Higher Higher 

(H. Wang et al., 
2013) 

Mouse 
Heart 

Plin5 over 
expression vs Wild 
Type 

Higher Higher Lower 

(H. Wang et al., 
2013) 

Mouse 
Heart 

Fasting vs feeding Higher Higher Lower 

Liver      
(Arruda et al., 2014) Mouse liver Ob/Ob vs wt  

HFD vs chow 
Higher Higher N/A 
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Table 4.2. Hypothesized mediators and regulators of Mitochondria-LD 
interaction 

 Cell type Technique Potential mediators of 
mitochondria-LD 
association 

(Jägerström et al., 
2009) 

NIH 3T3 Isolated mitochondria 
and lipid droplets in a 
cell-free system 

Factors on outer surfaces 
of organelles and factors 
in cytoplasmic fraction.  

(H. Wang et al., 
2011) 
Benador et al. 2018 

CHO, AML12, 
HL-1 
Primary brown 
adipocytes, INS1 

Site-directed 
mutagenesis and 
confocal fluorescence 
microscopy. 

C-terminus of Plin5 as 
potential regulator 
(Mitochondrial target 
unknown) 

(Stone et al., 2009) COS-7 Site-directed 
mutagenesis, confocal 
fluorescence 
microscopy, and cell 
fractionation. 

N-terminus of DGAT2 as 
potential recruiter 
(Directly targets outer 
mitochondrial membrane)  

(Boutant et al., 
2017) 

Primary brown 
adipocytes 

Co-IP Plin1-Mfn2 

(Yu et al., 2015) BAT Western blot analysis of 
mitochondrial proteins 
in isolated lipid droplets 
subjected to tryptic 
digestion, high salt 
wash, and detergent 
wash. 

Membrane hemifusion 
(Also supported by 
membrane thickening 
observed by EM) 
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